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and disclaims all liability for damages resulting from use of this
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Technical Support Site
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1 ABOUT LIEBERT NFORM

Liebert Nform is a software tool that monitors the condition of networked equipment, tracks alarms and
other conditions, then sends notifications and performs other management actions based on those

conditions.

The software may be configured to monitor and manage a wide variety of Liebert devices and other
equipment. The devices may be organized into geographical or functional areas, mapped on customized
floor plans and displayed graphically in a logical tree format.

Liebert Nform must be installed on a computer that acts as a server; client versions of the software may be

installed on an unlimited number of workstations for remote monitoring and management.

1.1 How Do You Contact Vertiv™ for Technical Support?

For help on setting up Liebert Nform or any other monitoring product, contact Vertiv™ Software

Technical Applications Support Center at:

Table 1.1 Technical support contact information

Liebert Nform
Technical Support

Liebert Nform Product Information:

Liebert Nform Support Website Log in:

UNITED STATES 1800 222 5877
FRANCE +33(0)146875152
CGERMANY +49(0)899919220
ITALY +39(0)2 98250 324
NETHERLANDS +31(0) 475503333
UNITED KINGDOM +441628403200
EUROPE +800 11554499
ASIA +800 11554499
AUSTRALIA 1800147704
NEW ZEALAND 0800 447415

1614 8416755
WORLDWIDE

FAX: 1740 833 8631
Product AllLiebert Products: www.VertivCo.com
Information

www.VertivCo.com

http://applications.liebert.com/nformsa

E-Mail for Technical Support:

liebert.monitoring@vertivco.com
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1.2 What is Liebert Nform?

Liebert Nform uses Simple Network Management Protocol (SNMP) and Vertiv™ Velocity Protocol to
monitor and manage a wide variety of networked equipment, protecting it from costly damage resulting
from power failures and mechanical breakdowns. The monitored equipment can include industrial air
conditioning units, Uninterruptible Power Supply (UPS) units and other devices that accommodate an
SNMP card to communicate over an Ethernet network. Liebert Nform will monitor and manage devices
manufactured by Vertiv™ or by other equipment makers.

Liebert Nform constantly monitors configured equipment, warns of problems ranging from power quality
to environmental conditions.

This product also permits configurable responses to equipment alarms, including support for audible
alarms, e-mail and on-screen notification.

1.2.1 How Does Liebert Nform Work?

Liebert Nform on a host computer communicates with managed devices using either SNMP or the
Velocity Protocol to detect problems ranging from power quality to environmental conditions.

The user has the option of expanding Liebert Nform’s network capabilities with additional licenses.
Licenses are available in increments of 30, 100 or 500 additional monitored and managed devices.

Liebert Nform employs the SNMP protocol and static IP addresses to issue notifications and warnings,
launch scripts and send e-mail messages. It uses HTML to graphically display system information for
devices with an SNMP card that is Web-enabled. Liebert Nform performs its monitoring and management
processes using the network—instead of requiring separate, expensive hardware and cables that might
run alongside network lines.
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1.2.2 Key Features

The following table summarizes important features available in Nform.
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Table 1.2 Key features of Liebert Nform

FEATURE IMPROVEMENT

The system supports a user-customized Dashboard. This view allows users to quickly create a
fullspectrum of charts and graphs that can represent a total system view of all managed devices,
aspecific device and/or a group of managed devices.

Large icons display a total count of devices by each state, including a numeric value representing

\E/);S\:board the total count of devices in alarm, devices with no communication and devices that are normal.
Status buttons and filters offer a quick way to select which devices to show in gadgets with
customized views of devices in a particular state. Status buttons toggle between customized
device status views and all devices. Filters are easy to apply in any gadget by simply entering text
to search for in the device definitions, such as IP address or name.

Customized views may be created to organize devices into groups or add graphic floor plans as

Area/Floorplan ; ) ) o . L

Views visual reminders of where devices are located. Device icons with labels and status indicators
offer a quick way to identify problem devices and their locations.

The Navigation Portal and Alarm Management Interface Window can be detached from the main

Detachable o ) ) ) ) )

Windows software application, thus allowing the Liebert Nform Viewer to be run on multiple screens. This

was specifically designed for deployment in IT Network Operation Centers (NOC).

Parametric Data
Trending

Priority Status
Polling

Alldevices can be configured for trending parametric data. This trend data can be viewed within
atrend graph and can be exported to afile that can be used to analyze parametric data from a
system view.

Users can define the polling priority for each managed device, allowing for quick response times
on critical equipment.

Internationalization

Users and Groups

The software supports the following languages: English, French, Italian, German, Spanish,
Simplified Chinese and Japanese.

Language settings are stored at each client, allowing users to specify their language of choice.

By default the system comes with three (3) predefined user groups: Administrator, Power User
and Operator. Users with Administrator privileges can administer users and groups for the
complete enterprise.

Users can also create new user groups and define the access level and rights of each group.

Audit Logging

Device Info Links

Alluser actions and configuration changes are tracked and stored in a server audit log file. This
gives the administrator the ability to monitor changes that are submitted to the Liebert Nform
server.

Devices can be configured for informational links that allow a user to create links directly in the
software to display online help files and/or user manuals.

Alarm Management

Additional Actions

Each device's alarm events have been predefined in three (3) default severity levels: Critical,
Warning and Information. These are the Vertiv*-recommended severity levels defined in the
software.

The software can be configured to auto-acknowledge alarms by severity level, thus allowing
intelligent processing of alarm-event data.

Shutdown: configuring graceful shutdown of client computers
Forward trap: sending traps received to a specific computer (host name or IP address)
Read data: collecting samples of data points from selected managed devices

Write data: changing values of selected data points based on specified alarms or events
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Table 1.2 Key features of Liebert Nform (continued)

FEATURE IMPROVEMENT

Animport utility allows transferring previously configured data that has been exported from an
earlier version of Liebert Nform (version 2.0 or later) on the same computer or a different
computer. Datathat can be transferred includes licenses as well as configured devices and email

Import Configuration
Data From Earlier

versions notifications.

) Datafrom Liebert Rack PDU devices may be viewed at the PDU, branch and receptacle levels
JEEEREE KIFIDR through the logical groups feature of Liebert Nform. Users may control receptacles individuall
Outlet Grouping 9 gicaigroup ; ¥ P v

or in groups—for example, turn receptacles on or off.

Liebert Rack PDU data may be used to generate reports about power usage, consumption,

PDU Power Reports L
P temperatures and utilization.

Maintenance Mode Scheduling Devices may be scheduled to be placed in maintenance mode, preventing device-related alarms
and Management from triggering configured actions. Images in the navigation view change to maintenance icons.

1.3 Who Can Benefit From Liebert Nform?

Any industry operating devices utilizing the SNMP protocol can benefit from using Liebert Nform to
protect valuable equipment, data and other assets in the event of power or mechanical failure.

Liebert Nform's protection can be extended beyond equipment manufactured by Liebert to encompass
other makers’ SNMP devices. Liebert Nform ships with templates—specifications and functionality—for
Liebert-built SNMP devices. Liebert offers templates for other manufacturers’ equipment; contact your
local Liebert representative, value-added reseller, or distributor for information.

1.4 Requirements for Liebert Nform

Visit the Vertiv™ Web site at www.VertivCo.com for the latest product information. The Web site always
has the most detailed and up-to-date information on system requirements and Liebert Nform’s
capabilities.

1.4.1 Connecting Host Computer and SNMP Devices

SNMP communication allows you to take full advantage of Liebert Nform’s features. The host computer
connects toan SNMP-enabled device over a network. Information and management commands may be
passed over the Internet, a Local Area Network (LAN) or a Wide Area Network (WAN) via SNMP protocol
and static IP addresses.

Liebert Nform works with a network connection and any of these types of cards:

1. SNMP card with Web capability such as the Liebert IntelliSlot® Web Card family
2. SNMP card without Web capability, such as the Liebert IntelliSlot SNMP card
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1.4.2 Requirements for Installing Liebert Nform

Before beginning installation, review these requirements:

System Requirements
e 2 GHzdual processor or better
e 2 GBRAM for server; 1GB RAM for Viewer only
e 3 GBfreedisk space for server; 1GB free disk space or better for Viewer

The Liebert Nform software (Visit www.VertivCo.com or contact your local Liebert
representative, value-added reseller, or distributor for information.)

This manual (download from the Vertiv™ Web site)

A computer with Microsoft” Windows® 8 or 8.1 Professional or Enterprise, Windows 7
Professional or Enterprise with SP1, Windows 10, Windows Server 2008 with SP2 and R2;
Windows Server 2012 (except Server Core) Windows Server 2012 R2 (except Server Core).

A monitor capable of 1280x1024 or higher screen resolution with a 16 Bit (or better) color
setting

A communications link between the SNMP device and the host computer: local network,
Internet or Intranet, utilizing SNMP protocol and static IP addresses

Availability of UDP ports 161 and 162 for SNMP communication and notification(trap)
Availability of UDP port 47808 for read-write access to devices with Velocity Protocol
Availability of TCP port 3442 for remote viewer connections
Availability of TCP port 443 for software registration
Availability of TCP port 80 for support Web site
Availability of TCP port 25 or TCP port 587 (if e-mail notification is desired
Availability of TCP port 1433 for SQL server database
Supported Databases

e SQL Server 2008

e SQL Server 2008 R2

e SQL Server 2012

e SQL Server Compact Edition (CE) v35 SP2

e SQL Server 2014

NOTE: We highly recommend using a SQL server if the Liebert Nform system will have more than 50
devices or may be expanded to 50 or more devices and more data logging frequency is desired.
See Database Menu on page 117 for additional database management information.
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e Ability to access the following Web sites for Software Assurance support:

http://applicationsliebert.com/nformsa/

https://publicservices.liebert.com/nformsa/

Totest access to each of these sites, click a link above or paste the URL into your browser.
e Thefirst link will take you to the Liebert Nform Support Log-in page.
e The second link will display a short message about the Software Assurance web service
and then take you to the Liebert Nform Support Log-in page.
o [feither link fails, contact your network administrator for assistance to verify network
connectivity and firewall settings.

e TCP/IP connectivity throughout the network

NOTE: Check with your System Administrator about the need to disable certain network or virus
protection software.

If you need help registering for Software Assurance, contact Vertiv™ (see How Do You Contact Vertiv™ for
Technical Support? on page .

1.4.3 Licensing

Liebert Nform may be installed as a full package or as a Liebert Nform remote client.
e The full package consists of the Nform Service and the Nform Client.
e The Liebert Nform remote client consists only of the Nform Client.

The license delivered with Liebert Nform allows users to configure the software to monitor and manage
devices from the server and an unlimited number of remote clients. Users have the option of expanding
Liebert Nform’'s network capabilities with additional licenses (see Ordering Parts and Licenses From Vertiv
on page 129). The delivered license also allows users to configure Liebert Nform to perform data logging
and forward traps to a network management site.

Liebert Nform can monitor any part of a network. Its functionality permits it to monitor any SNMP-enabled
device or any device with Velocity Protocol that can be contacted via the local network or the Internet.
These devices include those made by Vertiv™ and by other manufacturers (with Device Type Definitions
available from Vertiv™—see Tools Menu - Install DTD on page 120).
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1.5 Sample Liebert Nform Configuration

Example of Liebert Nform on a Network

Sample Liebert Nform configuration on page 8 shows one possible configuration of a Liebert Nform server
that is monitoring and managing various Liebert and non-Liebert devices. The network also has Liebert
Nform client software installed on another computer and a network management system.

When an alarmis received, Liebert Nform can send e-mail notifications, append alarm data to a file and

run scripts.

Figure11 Sample Liebert Nform configuration

ITEM DESCRIPTION

1 Network management system
2 Nform client

3 Nform server

4 Shut-down software client

5 Third-party NX device

6 Environmental unit

7 DC unit

8 Monitoring unit

9 Battery-monitoring unit

10 Ethernet
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2 INSTALLING THE SOFTWARE

This section explains how to install Liebert Nform, from the Web from a distribution CD.

For details on setting up an SQL Server database for a new Nform installation, see the ReadMe file in the
SQL folder on the CD (e.g, D\sgl\ReadMe.txt).

For details on upgrading an SQL Server database from an existing Nform installation, see the ReadMe file
in the SQL upgrade folder on the CD (e.g, D\sgl\upgrade\ReadMe.txt).

NOTE: The SQL CE database is adequate for monitoring fewer than 50 devices. For 50 or more devices,
We recommend installing the SQL Server database.

2.1 Installation

1. Insert the Liebert Nform CD in the CD drive. The Setup wizard starts automatically.
Note: If the Setup wizard does not open automatically, launch Setup.exe from the CD.
One way to do thisis: Click the Start button, then Run. In the Run window, Click
Browse to locate the file Setup.exe on the CD, highlight the file name and click Open.
Click OK to begin installation.
2. After viewing the Welcome and Readme information, read the Liebert Nform License
agreement.
e If you accept the terms and conditions of the license agreement, click | accept the terms
in the License Agreement and then click Next.
e Ifyou donot accept the terms and conditions, click | do not accept the termsin the
License Agreement and then click Cancel to abort the installation.
3. Inthe Select Setup Type window, shown below, choose the type of installation:
o Nform Full Package
For the application server—choose this for the computer that will be the Nform
application server on the network or for an installation with a single computer.
This option will install both server and client software.
¢ Nform Remote Client
For client workstations—choose this option if the full package is already installed on
another computer on the network.
This option will install client software only.
4. Click Next.
5. In the Destination Folder window:
e Werecommend using the default location for software installation. (To select a different
location, Click the Browse button and choose the location.)
e (If Nform Full Package on page 9 is selected in 3) Choose the type of database to be used:

Bundled Database (default)
Microsoft SQL Server Database

e Tocreate aprogram shortcut on the computer desktop, place a check mark M in the Add
shortcut to the Nform Viewer on the Desktop.
6. Click Next.
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7. Inthe Ready to Install the Application window, review the details and click Next to begin
installing the software. A dialog box displays a progress bar.
8. A message indicates that installation was successful. Click Finish to exit the Setup wizard.

Upon initial log-in, the Nform System Start-up wizard will be activated to complete the setup process (see
Registering for Software Assurance on page 10 and Nform System Start up on page 1.

2.2 Registering for Software Assurance

Registering for Software Assurance offers added benefits such as around-the-clock technical support
both on the Liebert Nform support Web site and by phone, as well as access to software updates,
technical resources and new and updated device definitions for products to be monitored.

The start-up process described in Nform System Start up on page 11 provides a quick way to register. You
may skip registration during the start-up process if you prefer to use the software for a temporary
evaluation period and register later.

With the new purchase of Liebert Nform software product, the first year (one year) of Software Assurance
(SA) maintenance is provided free of charge, commencing from the time of shipment. In addition, SA
maintenance also provides support and the ability to request new device support to be added to Nform.

If a customer is current and active with Software Assurance (maintenance) coverage, without any break
in coverage, software Upgrades will be available at no cost.

If SA maintenance expires, and, for example, customer decides to renew a year later, customer will be
required to purchase an additional year, (for the year of non-coverage), to get back current on
continuous coverage, before qualifying for free software upgrades.

For Example:
Customer’s Liebert Nform Express SA expires 12/31/15.
Customer renews (re-purchases) Express SA coverage for 1yr. on 12/31/16.
(Customer did not have continuous SA coverage for one year (Jan15-Jan16)).

For this example, to be eligible for free software upgrades, customer must now purchase 2 years
of SA coverage, to get them back to current. (1yr. renewal for Express SA coverage, and one
additional year for the year of non-coverage).

Otherwise, customer has the option of purchasing a new copy of Nform software product, of
which will include one year of free SA maintenance.

Contact your local Vertiv™ representative about resuming Software Assurance if the coverage
has lapsed.

For systems that are not connected to the Internet or are otherwise quarantined, follow these steps and
proceed to Registering Offline (Quarantined) Systems on page 14.
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2.2.1 Evaluation Installation
Liebert Nform may be installed in a 90-day evaluation installation mode by:
e notentering a product license key,
—or—
e entering a product license key but without registering for Software Assurance

If no product license key is entered, the evaluation setup permits monitoring up to five devices until a
base license key is entered or 90 days, whichever comes first. If no product license key is entered within
90 days, Liebert Nform’s monitoring capability will reduce to one device. The viewer will display
[EVALUATION] in the title bar until a product license is entered. An Evaluation Installation permits
monitoring up to five devices, but it will have no access to software updates and other resources.

If you entered a product license key but did not register for Software Assurance, you may configure as
many devices as your license permits and monitor them for 90 days; you will not have access to software
updates and other resources.

If the LiebertNform system is not registered, you will be prompted about registration in the title bar and
with a reminder dialog. See Title Bar on page 11,and

Title Bar

e Thetitle bar displays a reminder in brackets:

e [EVALUATION] if you have not yet entered your Nform license keys or have not
registered for Software Assurance

o [UNREGISTERED] if you have not yet registered your Nform system or
e [EXPIRED] if you need to renew your subscription.

Reminder Window

If the Nform system has never been registered, a Reminder window appears when a user with permission
to manage licenses logsin to a server.

Toregister your Liebert Nform software after the start-up process described in Nform System Start up on
page 11, perform one of the following when logged in as a user with permission to manage licenses:

e Click Yesin the Reminder window shown above, then refer to Enter Customer Information for
Nform and Software Assurance on page 31 for details on the window that opens.

e Click the Application menu, then Register Product at any time to begin the registration
process (see Register Product on page 31 for details).

2.3 Nform System Start up

The Nform System Start-up process described in this section allows you to set up administrator access to
Liebert Nform, enter any license keys purchased with the software and register those license keys for
Software Assurance. Software Assurance offers added benefits such as software updates and technical
support. See Registering for Software Assurance on page 10 for more information.
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FOR INITIAL START-UP ONLY: User Name = “Administrator” (No Password)

A built-in Administrator account with no password is created during installation; this account has full
access to all features and can add users with varying levels of access. To protect configuration settings, all
users require a password.

The Nform System Start-up wizard opens immediately after the first log-in to the Nform Viewer while the
Administrator password is not yet assigned.

The start-up wizard guides you through these steps:

STEP FORDETAILS, SEE:

1. Setapassword for the Administrator account (the built-in account created | Set Administrator Account Password
during installation). on page 13

Create aseparate Nform user account with administrator privileges. ‘ ,
; ; : Enter Customer Information for Liebert
Create an account on the Liebert Nform Support Web site (with the user Nform and Software Assurance on page

account information from step Create a separate Nform user account with 13
administrator privileges. on page 12).

Enter license keys purchased with your system. _ )
Enter License Keys and Register on

5. Register your system for Software Assurance using the license keys entered page 13

in step Enter license keys purchased with your system. on page 12.

We recommend completing all these steps immediately after installation to simplify the setup process.
The only step required at this time, however, is setting an Administrator password. The remaining steps
may be completed later. To do these steps later, see Register Product on page 31.

Start the Wizard

To launch the Nform System Start-up wizard:

e Start the Nform Viewer.

e Oninitial start-up, the user name is Administrator and no password is required. The user may
need to enter the host name or IP address of the Liebert Nform server on initial start-up.

e User name: Administrator (box filled in for initial start-up)
e Password: (None required for initial start-up)

e Server:localhost (box filled in if the Viewer is started on the Nform server) or

the host name or IP address of Nform server where Nform Full Package
resides

e The Nform System Start-up wizard opens. Proceed to the next section, Set Administrator
Account Password on page 13.
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2.3.1 Set Administrator Account Password
After the Nform System Start-up wizard opens:

1. At the welcome screen, click Next.
2. The Set Administrator Account Password window opens, as shown below.

The Administrator has full access to all features of the software and is generally reserved for
use in emergencies.

NOTE: A password must be set for the built-in Administrator. For security, it cannot be skipped.

We recommend creating at least one separate user account for daily use and for Software
Assurance registration, as described in Enter Customer Information for Liebert Nform and
Software Assurance on page 13.

3. Enter a password in the Password box, then re-enter it in the Confirm Password box.

The password is case-sensitive and must consist of two to 14 characters—with any
combination of letters, numerals and symbols. Be sure to record the password in a secure place.

4. Click Next.

2.3.2 Enter Customer Information for Liebert Nform and Software Assurance

The Enter Customer Information window allows you to create a second administrative user account, in
part to act as a backup to the built-in Administrator account in case one of the passwords is lost or
forgotten. If you register for Software Assurance (SA), the second administrative user account will be used
to generate a technical support account on the Nform Support Web site.

2.3.3 Enter License Keys and Register
The final step in the start-up wizard is to enter any license keys purchased with Liebert Nform.
We recommend entering these keys now to simplify the setup process and proceed with registration.

This may be done at a later time; however, the system will operate in evaluation mode until a base license
key is entered. See Enter the License Key on page 28.

If no product license key is entered, Liebert Nform will monitor up to five devices until a base license key is
entered or 90 days, whichever comes first. If no product license key is entered within 90 days, Liebert
Nform’s monitoring capability will reduce to one device. Liebert Nform screens will display the word
[EVALUATION] in the title bar. If no license key is entered, the evaluation setup permits monitoring up to

five devices; you will not have access to software updates and other resources.

If you entered a product license key but did not register for Software Assurance, you may configure as
many devices as your license permits and monitor them for 90 days; you will not have access to software
updates and other resources.
Toinstall a Liebert Nform license key:

1. Inthe Licenses window, click the Add button at the top right.

2. Readthelicense agreement, and click l accept to continue.

3. Inthe Add License window, enter the license key from the sticker on the CD case or the
certificate provided by Vertiv™ then click OK. There is no need to enter hyphens (-) in the
license key.
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4. Ifyou purchased additional licenses, repeat Steps 1to 3 to install each license.

After installation, the license key numbers appear in the Licenses window or may be viewed
through the Help menu. See View License Key Information on page 29.

5. Click the Register button toinitiate registering the Nform system.

NOTE: To register the product offline (manually), refer to Registering Offline (Quarantined) Systems
on page 14 for details on using the Export Registration button to create an encrypted file for manual
registration.

6. A confirmation dialog box appears if registration was successful. The following error message
appearsif the licenses could not be registered.

2.3.4 Registering Offline (Quarantined) Systems

For systems that are not connected to the Internet or are otherwise quarantined, follow these steps to
complete the registration process. This involves generating a registration file to take to another computer,
onethat isonline, registering at the Liebert Nform site on that computer, then generating a file to enter in
the Nform installation on the offline computer.

NOTE: Registration may be delayed for 90 days. During that time, Liebert Nform will display reminders
to register the software installation.

1. Export the registration file.

e After entering the appropriate license keys (Enter License Keys and Register on page 13),
click the Export Registration button.
The Registration Update window displays a message confirming the creation of a product
registration request file and its location, along with the URL to complete the process:

e Theproduct registration request file is called Registration.bin and may be found on the
same machine where the Viewer is running in the export sub-folder of the user folder.

e The URL tovisit is http;//applicationsliebert.com/nformsa/.
2. Copy product registration request file to an Internet-enabled computer.

e Navigate tothe product registration request file called Registration.bin, which may be
found in the export sub-folder in the user folder on the machine where the Viewer is
running.

ﬂ:? C:\Nform\user\export E]@W
7

. File Edit View Favorites Tools Help ci,r

@Back - J [ﬁ /‘j\ Search ‘[.EjFolders " x

—
Folders X == ane = =~ Jate Modified Size | Type

- 02| .
= 103 Nfarm 1a] ‘ BT 1202011 1:54PM 1KE BINFie
# [ bin SN ===
# ) db
) docs
7= lam
T ——
¢ = | user
. u

[C5) samples
Type: BIN File Date Modified: 12/6/2011 1:54 PM Size: 704 bytes 704 bytes :ﬂ My Computer
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3. Visit the specified Nform SA site (http://applicationsliebert.com/nformsa/) on a different,
Internet-enabled computer.

o Click Register Product in the My Nform System menu.

4. Upload the exported product registration file.

e Click the Browse button and locate the product registration file Registration.bin, which
was exported in step 1.

e Clickthe REGISTER button. If successful, a link appears to a registration response file.
5. Download the registration response file and copy it to the Nform system.

e Click the link to download the response file for import into the Nform system.

e Copy that file to the offline computer where Nform is installed.
6. Open Liebert Nform on the offline computer system to complete the registration.

o Click the Application menu, then Register Product.

e Click the Browse button to locate the registration response file, which was downloaded from the
Nform SA site in step 5.

e Click Finish.
e The Registration Update window displays a message indicating whether the registration was
successful.

2.3.5 Adding Subsequent Licenses

If another license for either Liebert Nform is added to a system without an internet connection, the steps
in Registering Offline (Quarantined) Systems on page 14 must be performed for the new license. Nform
displays a reminder to register for software assurance.

Systems that are connected to the Internet will get the new license registered automatically as detailed in
Enter License Keys and Register on page 13.

2.4 Upgrading From Older Versions of Liebert Nform

NOTE: Due to enhanced Federal Information Processing Standard (FIPS) encryption, in Liebert Nform
4.1, upgrading from any version of Liebert Nform to Liebert Nform 4.11 (or later) will reset the
administrator’s password to blank and require re-entering all users passwords, to comply with the
enhanced FIPS encryption policies.

The configuration from earlier versions of Liebert Nform (version 2.0 or later) can be transferred to new
installations. The upgrade and transfer process requires exporting data from the Liebert Nform 2.X
application.

The export can be done either of two ways:

e Usethe export feature from the File menu in the Liebert Nform 2.5.002 or later version (see Use
the Export Feature in Liebert Nform 2.X on page 16), or

e Run the export_utility.exe program in the Upgrade folder on the Liebert Nform 4.X CD (see Use
the Export Utility from the Liebert Nform 4 CD on page 16).

NOTE: After upgrading from an earlier 4.x version of Liebert Nform, users with permission to manage
licenses (see Assigning Users to Groups on page 84) will see the Reminder window described in
Registering for Software Assurance on page 10 on the first log in.
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2.4.1 Use the Export Feature in Liebert Nform 2.X
To use the export feature in Liebert Nform version 2.X:

e Start the Viewer, making sure you have access to the import/export function.
e Click the Configure tab.
e Click the File menu, then choose Import/Export.

o Click to place a check mark M next to each type of data you wish to export, or click Select All to
check all boxes. (Click Clear All to remove all check marks.)

The exported data that will be used for the upgrade includes:

e Liebert Nform license keys

e Shut-down software licenses
e Managed devices

e Shutdown clients

e E-mail actions

e Thetreeatright displays the location where the export files will be saved. If desired, select a
different location.

e Click the Export button to create text files of all selected data.

e Checkto make sure the files are successfully exported, then copy all export files to the Export
folder in the Program Files folder on the Nform 4 server.

2.4.2 Use the Export Utility from the Liebert Nform 4 CD
Torun the export_utility.exe program that may be found in the Upgrade folder on the Liebert Nform 4 CD:

e Runthe program called export_utility.exe, which may be found in the Upgrade folder on the
Liebert Nform 4 CD. (Double-Click the file or click the Start button, then click Run, enter the
full path or Browse to locate the file, then click OK)

e Click the File menu, then choose Import/Export.

e The Nform Export Utility displays steps executed during the export process, then a
confirmation window asks whether you wish to open the folder to view the exported files. Click
Yes to do so.

The exported data that will be used for the upgrade includes:

e Liebert Nform license keys

e Shut-down software licenses
¢ Managed devices

e Shutdown clients

e E-mail actions

e Check to make sure the files are successfully exported, then copy all export files to the Export
folder in the Program Files folder on the Nform 4 server.

2.4.3 Import Exported Data from a Different Server

If Liebert Nform 4 will be installed on a different server, install it, create a temporary folder for the export
files, then use the Nform Tools application (also see Using Nform Tools on page 115):
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e Install Liebert Nform 4 as described in Installation on page 9.

e Create atemporary folder on the Nform 4 server and copy the export files from the Export
folder from the program folder where Liebert Nform 2.X was installed.

e On the Liebert Nform 4 server, open the Nform Tools window. To do this, Click the Start button,
then Click Programs, Liebert Nform and finally Nform Tools.

e Inthe Liebert Nform Tools window, Click the Tools menu, then on Import 25 Data.

e Inthe Directory box, enter the full path or click the Browse button to locate the folder
containing the exported files, then click Open.

e Click Import. The import utility will temporarily stop the Nform service and import the
appropriate files—the service will restart automatically when the Tools application is closed.

A message confirms the process is complete.

e When finished, close the Tools application by clicking on the Application menu, then Exit (see
Application Menu - Close Nform Tools on page 117).

The Nform service will be restarted automatically on exit.

2.4.4 Import Exported Data From the Same Server

If Liebert Nform 4 will be installed on the same server, the installation will automatically detect the
presence of the Liebert Nform 2.X application, import the data from the export folder (license keys,
managed devices, shutdown clients and e-mail actions), then remove the Liebert Nform 2.X application.

NOTE: The export MUST be run manually for the upgrade to import data properly from the Liebert
Nform 2.X application.

A copy of the Liebert Nform 2.X data files and exported files will be saved.

e Install Liebert Nform 4 as described in Installation on page 9.

e Ifyou select the Nform Remote Client Only option on a computer running a Liebert Nform 2.X
client, server or both, you will have the option to uninstall the Nform 2.X client or server
software automatically.
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3 OVERVIEW

This section provides a quick look at the features available with various SNMP devices and the functions
accessible through Liebert Nform's desktop, tabs, menus and toolbar buttons.

3.1 The Viewer Window - Overview

Figure 3.1 Nform Viewer window

Administrator - Liebert® Nform o8] %
=
1 Application  View  Configure Tools  Help
Liebert'Nform
6 DASHBOARD
o =
Device Status: All
vice
Alarm Status: All Alarm Severity: All

NOTE: Changing the size of the system-display text from 100% may affect the appearance and location
of the icons and menus.

ITEM DESCRIPTION

1 Menu bar

2 Top frame

8 Bottom frame

4 Configuration buttons
B Viewer display area

6 View tabs

7 Status buttons
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The Menu Bar at top left offers access to all Liebert Nform features (see Menus on page 23):
e Application
e View
e Configure
e Tools
e Help

Status Buttons in the top frame show the number of devices by condition (see Buttons on page
21). This top frame may be minimized to expand the Viewer Display Area. The device conditions
are:

e No Communication
e Normal

e Maintenance

e Alarm

View Tabs determine which type of information—device status, navigation tree or alarm data—
is shown in the Viewer Display Area (see Buttons on page 21):

e Dashboard (the default view when the Viewer opens, shown above)

e Navigate
e Alarms

The Viewer Display Area shows status, configuration or alarms information, depending on
which view tab is selected (see Operation - Using the Viewer on page 97). The default
Dashboard view above shows gadgets with three types of data for all devices:

e Device Status
e Alarm Status
e Alarm Severity

Configuration Buttons in the bottom frame are shortcuts to Liebert Nform setup features (see
Buttons on page 21). These functions are also available from the Configure menu. This bottom
frame may be hidden to expand the Viewer Display Area.
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3 Overview

3.1.1 Buttons
The following tables list the buttons available in the Viewer and where to learn more about each.

NOTE: Changes to system display text size, different from 100% setting, may affect the appearance and
location of graphic icons and menus.

The number of devices in each status displays below the status buttons.

BUTTON

%,

DESCRIPTION

No
Communication

Click to toggle dashboard view between
not-communicating and all devices.

COLORSTATUS

Gray symbol - all devices are communicating
with server.

Flashing - requires attention, Tor more devices
not communicating with a configured
computer

X

Normal

Click to toggle dashboard view between

devices operating normally and all devices.

Maintenance

Click to toggle dashboard view between
devices in maintenance mode and all
devices.

Green symbol-1or more devices operating
normally

Flashing - requires attention, no devices
operating normally
Gray symbol - no devices in maintenance mode

Flashing - One or more devices are in
maintenance mode

Alarms Present

Click to toggle dashboard view between
devicesin alarm and all devices.

Gray symbol - no devices currentlyin alarm

Flashing - requires attention, Tor more devices
in alarm

NOTE: Use the arrow next to the tabs, » to open the selected view in a separate window.

Table 3.1 View tabs on the desktop

TAB

Navigate. View navigation tree with configured devices and floor plans, Web browser interface, parametric data, alarms, trend data and

Web links in Detail area. See Navigate Tab - Device on page 104.

Alarms tab. View alarm data for all configured devices in Detail area. See Alarms Tab on page 108

21
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Table 3.2 Configuration buttons on the desktop

BUTTON DESCRIPTION

Configure Licenses. Shortcut to Configure > Licenses to add Nform licenses. See Enter the
License Keyon page 28

Configure Server Options. Shortcut to Configure > Server Options to view or change global
settings.See Configuring Server Options on page 37

Configure Devices. Shortcut to Configure > Devices to add devices and floor plans. See
Configuring Devices on page 47

Configure Actions. Shortcut to Configure > Actions to set up actions (e.g., send e-mail, write
file). See Configuring Actions on page 69

Configure Users & Groups. Shortcut to Configure > Users and Groups to add user accounts
and customize user options. See Configuring Users and Groups on page 83
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3.1.2 Menus

The menu bar at the top of the Viewer window provides access to all Nform features and is summarized in
the following table.

3 Overview -



Table 3.3 Menu options - summary

MENU OPTION FUNCTION (CONFIGURATION BUTTON, IF ANY) FOR MORE DETAILS, SEE:
Nform Tools Open the Nform Tools application Nform Tools on page 31
Register Product Register for Software Assurance Register Product on page 31
Restart Session Restart the Client session without logging out Restart Session on page 32
Application
Loain As Log in with a different user name and password Lo in As on pade 32
¢ without closing the Viewer 9 pag
: Close the Viewer window (requires login the next )
Exit time the Viewer is opened) Bxit on page 32
Show Expanded Show large status buttons at top of window or Show Expanded Top Frame on page
Top Frame display smaller status buttons &
Show Expanded Ezstvgnir T ERMIEET e USRS Show Expanded Bottom Frame on
View Bottom Frame of the window page 33
Expand to full-screen display (no title bar, menu
Fullscreen bar Full Screen (F11) on page 34
or window frame) or restore to normal window
Devices AL quICes ISR Configuring Devices on page 47
configuration
) Create actions—e.g., e-mail notifications—to o )
Actions be executed when an alarm is received ComiEUie GRS L (e
Shutdown Configure shut-down client computers that may Configuring Shutdown Clients on
Clients be selected for shutdown actions page 66
) Add devices, floor plans and logical groups to the Configuring Views for the Navigate
Views ' )
configuration Tab on page 59
Usersand Create new users and define access Configuring Users and Groups on
Groups privileges for groups of users page 83
Configure
) Add licenses purchased from Vertiv™ for )
Licenses Liebert Nform or shut-down software. Enter the License Key on page 28
Server Change global settings—e.g., for language, Configuring Server Options on page
Options alarms, devices, e-mail servers, SNMP 37
Change the User Password
ST Create or change a password to use at login on page 27
Password
Add Individual Users on page 83
User S(;Js;omlze user preferences for language, time Configuring User Options
Options alarm and other colors, visual and audible alerts o [PRgRE5
Export atext file of records with: Submenu items:
. Alarm History - recent alarms Export Alarm History on page 89
xport
o0l Action History - recently executed actions Export Action History on page 90
ools
Data Log History - trend graphs of data points Export Data Log History on page 91
Reports Generate tabular data or charts of records about Reports on bage 92
P status or history of monitored devices. P Pag

24
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3 Overview

Table 3.3 Menu options - summary (continued)

MENU

Help

OPTION FUNCTION (CONFIGURATION BUTTON, IF ANY) FOR MORE DETAILS, SEE:

Contents Open Liebert Nform help to the Contents tab =

Index Open Liebert Nform help to the Index tab —

Supported Show alist of device types supported by the -

Device Types Nform software

Technical Open Liebert Nform help to display contact -

Support information for Liebert Nform technical support

Get software updates (w/ Manage Licenses
Check for Updates —

About Liebert
Nform

permission)

View details on Nform Viewer version, server,
database, installed license keys, registration,
how to contact technical support

View License Key Information on
page 29
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4 GETTING STARTED WITH LIEBERT NFORM

This section provides details on starting the Nform Viewer, logging in and entering license keys to
configure devices for monitoring.

The software comes with a built-in Administrator account with full access to configuration and
monitoring. Other users may be added with any combination of viewing and configuration privileges.

NOTE: The Liebert Nform software makes automatic adjustments to operate correctly with the
Windows firewall if enabled.

Saving Configuration Changes

Changes to Liebert Nform’s configuration are made immediately and do not need to be saved before they
take effect.

4.1 Start Liebert Nform

Tostart the application:
e Double-click , the Nform Viewer icon on the desktop.

—-0or —

e On the Start menu, click Programs > Liebert Nform > Nform Viewer.

4.2 Log on as Administrator and Connect to Server
The Log in to Liebert Nform window opens, asking for a user name, password and the server where Liebert
Nform was installed.

e Oninitial start-up, the user name is Administrator and no password is required. There is no
need to specify a server if the Viewer is started on the Nform server.
e User name: Enter your user name—if none assigned, enter Administrator
(box filled in for initial start-up).

e Password: Enter the password that was assigned to you—if none assigned,
leave blank (none required for initial start-up or when using the evaluation
edition)

o Server: Enter localhost (box filled in if the Viewer is started on the Nform
server)—if the Viewer is started on a client computer, enter the host name or
IP address of Nform server where Nform Full Package resides.

e Clickthe Log in button.

NOTE: If you have trouble logging in, click the About button for technical support information.

4.3 Change the User Password

The Change Password menu item allows users to change their own passwords at any time, as long as they
have permission to do so.

This option also applies to users who have an account created for them with the User must change
password at next log in option (see Add Individual Users on page 83) and for initial start up of an
evaluation edition.
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Tochange the password from the Configure menu:
e Start the Viewer with permission to change the password (see Add Individual Users on page
83).
¢ Click the Configure > Change Password.
e Enterthe existing password in the Old Password box.

(During thefirst log in, leave this box blank.)
e Enterapassword in the New Password box.

The password is case-sensitive and must consist of 2 to 14 characters—with any combination
of letters, numerals and symbols. Be sure to record the password in a secure place.

e Re-enter that password in the Confirm Password box.
For information on other ways to set passwords:

e For setting passwords in the Nform Start up Wizard on initial start up, see SectionNform
System Start up on page 11, especially Set Administrator Account Password on page 13.

e Passwords may also be assigned when creating or editing user accounts, as described in Add
Individual Users on page 83.

4.4 Enter the License Key

A Liebert Nform license key must be installed for full use of Liebert Nform'’s features, as described in the
following steps. If you purchased additional licenses, repeat the following steps to install each license.

NOTE: The license key delivered with Liebert Nform permits a certain number of devices and unlimited
users. To purchase a supplemental license key for additional devices (30, 100 or 500), contact your
local Vertiv™ representative or see Ordering Parts and Licenses From Vertiv on page 129.

If another license for Liebert Nform is added to a system without an internet connection, the stepsin
Registering Offline (Quarantined) Systems on page 14 must be performed for the new license. Liebert
Nform will display the reminder below.

Systems that are connected to the Internet will get the new license registered automatically as detailed in
Enter License Keys and Register on page 13.

4.41 Add aLiebert Nform License Key

Toinstall a Liebert Nform license key:
1. Start the Viewer with permission to manage licenses (see Assigning Users to Groups on page
84).
2. Click the Configure Licenses icon at the bottom of the window (or click the Configure >
Licenses).
In the Licenses window, click the Add button at the top right.
Read the license agreement, and click | accept to continue.
5. Inthe Add License window, enter the license key from the sticker on the CD case or the

certificate provided by Vertiv™ then click OK. There is no need to enter hyphens (-) in the
license key.

~ o

After installation, the license key numbers appear in the Licenses window or may be viewed through the
Help menu. See View License Key Information on page 29.
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4.4.2 View License Key Information

Users with Licenses access (see Assigning Users to Groups on page 84) may view information about
installed license keys in either of two ways:
e Licenses Window
e Start the Viewer with permission to manage licenses (see Assigning Users to Groups on
page 84).
¢ Click the Configure Licenses icon at the bottom of the window (or Click Configure >
Licenses).
e Click a license key number to view a description in the Select License Details area.
Choosing multiple license keys—with shift-click or control-click—will change the display
to show details of all selected license keys.
e Help - About Liebert Nform Window

e Click Help > About Liebert Nform.
e Click the License tab to view details of all license keys that are installed.

Toremove a license key, see Deleting a License Key on page 123.
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5 USING THE APPLICATION MENU

The Application menu allows you to restart the Nform service without closing the Viewer, install
definitions for new equipment purchased from Vertiv™, restart a session without logging out, log in as a
different user and exit the application.

5.1 Nform Tools

This menu item provides quick access to the Nform Tools application.

The application may be opened from the Start menu (see Open the Nform Tools Application From the
Start Button on page 115) or directly from this menu item in the Viewer.

To open the Nform Tools application from the Viewer:

e LogintoWindows on the Nform server as a user with administrator privileges on that machine.

e Start the Viewer on the Nform server and log in as a user with start/stop server permission (see
Assigning Users to Groups on page 84).

e Click Application, then Nform Tools.
e (Windows Vista, Server 2008 and later) A User Account Control (UAC) message appears,
requesting your permission to start the application. Click Allow to continue.

See Using Nform Tools on page 115 for complete details on the Nform Tools application.

5.2 Register Product

This menu item allows you to register if the Nform system has never been registered or the registration
has expired or will expire within 60 days (see Registering for Software Assurance on page 10).

NOTE: This menu item is disabled after the product is successfully registered.
Toregister or renew registration:
e Start the Viewer and log in as a user with permission to manage licenses (see Assigning Users
to Groups on page 84).
o Click Application > Register Product.
e Proceed to the next two sections:

e Enter Customer Information for Nform and Software Assurance on page 31
e Enter License Keys and Register on page 32

5.2.1 Enter Customer Information for Nform and Software Assurance

This window may have information filled in depending on the account used tolog in:
e Ifyou login asa user with administrative privileges—other than the built-in Administrator

account—some account user information is filled in. No new account will be created.
e Ifyou log in as Administrator (built-in account), a second administrator account will be created.
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5.2.2 Enter License Keys and Register
The final step in the start-up wizard is to enter any license keys purchased with Liebert Nform.
We recommend entering these keys now to simplify the setup process and proceed with registration.

This may be done at a later time; however, the system will operate in evaluation mode until a base license
key is entered. See Enter the License Key on page 28.

Toinstall a Liebert Nform license key:
1. Inthe Licenses window, click the Add button at the top right.
2. Readthelicense agreement, and click l accept to continue.

3. Inthe Add License window, enter the license key from the sticker on the CD case or the
certificate provided by Vertiv™ then click OK. There is no need to enter hyphens (-) in the
license key.

4. If you purchased additional licenses, repeat steps 1to 3 to install each license.

After installation, the license key numbers appear in the Licenses window or may be viewed
through the Help menu. See View License Key Information on page 29.

5. Click the Register button to complete the process. A confirmation dialog box appears if
registration was successful or an error message appears if the licenses could not be registered.

5.3 Restart Session

When needed, you may restart the Client session without closing the Nform Viewer or having tolog in
again. Todo this:

o Click Application > Restart Session.

5.4 Login As

When needed, you may log in with a different user name and password without closing the Nform Viewer.
Todothis:

e Click Application > Log in As.

5.5 Exit

Toclose the Viewer window:

e Click Application > Exit.
Log-in will be required the next time the Viewer is opened.

The Liebert Nform service keeps running in the background even after the Viewer window is closed. For
details on the service, see Starting or Stopping the Liebert Nform Service on page 113.
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6 USING THE VIEW MENU

The View menu lets you quickly increase the size of the Viewer Display Area by minimizing the status
buttons at the top, hiding the configuration buttons at the bottom or switching to full-screen display
mode.

6.1 Show Expanded Top Frame

The default Viewer window has large status buttons in the top frame. This top area may be minimized to
enlarge the Viewer Display Area. The function of the status buttons remains the same if the frame is
expanded or collapsed. (For details on the status buttons, see Overview on page 19.)

To expand or collapse the top frame:

e On menu bar, click View > Show Expanded Top Frame to place or remove a check mark:
e Place acheck mark M to show large buttons.
e Remove the check mark from the box [0 to minimize the status buttons.

Figure 6.1 Status buttons expanded and collapsed

% VERTIV..

ITEM DESCRIPTION

1 Top frame expanded, large status buttons

2 Top frame collapsed, minimized status buttons

6.2 Show Expanded Bottom Frame

The default Viewer window has configuration buttons in the frame at the bottom of the window. These
buttons may be hidden to enlarge the Viewer Display Area. All features available from the configuration
buttons are still accessible from the Configure menu. (For details on the configuration buttons, see
Overview on page 19.)

Toexpand or collapse the bottom frame:

e On menu bar, click View > Show Expanded Bottom Frame to place or remove a check mark:

e Place acheck mark M to show the configuration buttons.
e Remove the check mark from the box O to hide the status buttons.
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6.3 Full Screen (F11)

The Viewer window may be maximized to full-screen display mode with no menu bar. Full-screen mode
expands the Viewer window to fill the monitor. This is similar to the standard Windows Maximize-window
mode, but also hides the window frame, title bar and menu bar. To reveal the menu bar while in full-screen
mode, move the cursor to the top of the screen.

To enter full-screen display mode:

e Onthe menu,click View > Full Screen.
e Onthekeyboard, press F11.

To exit full-screen mode:
e Onthekeyboard, press F11.

e Hover the cursor over the top of the screen to display the menu bar, then click View > Full
Screen to clear the check mark.
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7 CONFIGURING USER OPTIONS

Users may customize their preferences to select:

e |language

e Timezone

e Colors for alarms, backgrounds and graphs
e Preferences for visual alerts of alarms

e Preferences for audible alerts of alarms

The User Options window has four tabs that allow customizing a user’s view and alerts.

To access the user options:

1. Onthe menu bar, click Configure > Users and Groups.
2. Select the user to update, and click Edit.

3. Inthe lower-right section of the dialog, click User Options.
The User Options dialog opens.

7.1 User Options - External Tab

The External tab chooses a language for the display of text in all Viewer menus, windows and dialog boxes
in the Liebert Nform application.

To choose a display language

e Select alanguage from the drop-down list, then click OK to accept the changes.
e Restart the Viewer for the language change to take effect.
7.2 User Options - General Tab

The General tab sets time zones and alarm colors.

To select the displayed time zone
1. Choose Local time (the default) of the user’s workstation.
—or-
Server time—the time of the server where Liebert Nform is installed.

2. Then click OK to accept the changes.
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To select displayed alarm colors

1. Inthe Alarm Colors section, select the Unacknowledged, Acknowledged and Background
buttons to customize the color schemes for the user’s alarms.

NOTE: These changes apply to display in the Alarms tab (see Alarms Tab on page 108).

2. Inthe Color window, choose a color from the swatches or custom colors, then click OK.
e Todefine a custom color, click Define Custom Colors, then select a color using the slider
tools or enter RGB values in the Red, Green and Blue boxes, and click OK when finished.)
Examples of the colors are displayed in the Alarm Colors section.

3. When finished, click the OK button to accept the changes.

7.3 User Options - Visual Alerts Tab

Click the Visual alerts tab in the User Options window to specify how the user will be notified when a new
alarm is received:

e Bring application to the foreground - the Viewer window comes to the foreground of the user’s
computer screen.

e Flash taskbar button - the Liebert Nform button flashes in the Windows taskbar of the user’s
computer screen.

o Display system tray popup message- a message appears above the Windows system tray.
For each option:

e Place a check mark M to select it (or remove the check mark to deactivate it).

e Choose a minimum level of alarm severity from the drop-down list. For example, if Warning is
chosen, the selected option occurs for any alarm with Warning or higher level of severity.

e When finished, click the OK button to accept the changes.

7.4 User Options - Audible Alerts Tab

Click the Audible alerts tab in the User Options window to specify whether sounds are assigned to alarm
severity levels. Alarm sounds are disabled by default.

e Toactivate any alarm sounds, place a check mark M in the Enable Audible Alerts box (or
remove the check mark to disable all sounds).
e Foreach alarm severity level (for example, Critical, Warning, Information):
e Choose a sound from the drop-down list—for example, Beep. The default is None.
e Tolisten toasound, select it from the drop-down list, then click the right arrow button to
the right of the list.

NOTE: The sounds to be played with each choice may be changed using the sound applet in the
Windows Control Panel. Each version of the operating system may have different default sounds.

e When finished, click the OK button to accept all changes in the User Options window.
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8 CONFIGURING SERVER OPTIONS

This feature allows you to specify global settings for configuration options. These options are selected by
default in various configuration windows, but any option may be locally customized for a particular device
or action.

1. Start the Viewer (see Assigning Users to Groups on page 84 for permission required for various
functions).

2. Click the Configure Server Options icon at the bottom of the window (or Click Configure >
Server Options).

3. The Server Options window has tabs for various types of options. Refer to the following sections
for details on each tab.

NOTE: Consider the following when deciding on the recovery model for your Nform database(s). By
default, the recovery model is "Full." However, you can use the "Simple" recovery model to keep the
space requirements small, but the disadvantage of this model is that it does not support point-in-time
recovery. The decision is between the importance of recovering stored Nform data in the event of a
lost or damaged data file and the rate of disk consumption from rapid increase in log-file size. Consult
with your database administrator to determine the best approach and back-up strategy.

8.1 Server Options - General Tab

e Start the Viewer (see Assigning Users to Groups on page 84 for access privileges).
e Click the Configure Server Options icon at the bottom of the window (or Click Configure >
Server Options).
e Click the General tab.
e Inthe Description box, enter the name of the server host computer where the software is
installed.
e The Locale section requires permission to manage server parameters (see Assigning Users to
Groups on page 84).
To make changes:
e Inthe Language box, Click the drop-down list and choose a language to be used by the
server when localized text is needed—primarily for actions and some alarm information.
e The service must be restarted before this change will take effect .
e The Audit log file area requires permission to manage logging parameters (see Assigning Users
to Groups on page 84).
This section displays the name and size of the audit log, a record of logins and logouts and
changes to the system configuration. We recommend keeping the default settings.
e The default File name and full path is: CANform\log\Audit.log.
e The default Maximum size of the audit log file is 10 MB.
e Click OKtosave changes.

NOTE: If the language was changed, the service must be restarted for the change to take effect (see
Application Menu - Service on page 117).
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The Liebert RSD global value area requires permission to manage server parameters (see
Assigning Users to Groups on page 84)
This feature allows you to set a global site ID for remote monitoring, which may be overridden
for any device (see Liebert RSD Tab on page 52). To activate remote monitoring:
e Checkthe Enable Liebert RSD Support box to activate the function.
e Enterthe appropriate ID in the Site ID box. (Note: The string is supplied by Liebert
Services for users with Liebert Nform and a service contract.)

8.2 Server Options - Event Log Tab

Start the Viewer with permission to manage logging parameters (see Assigning Users to
Groups on page 84).

Click the Configure Server Optionsicon at the bottom of the window (or Click the Configure
menu, then choose Server Options).

Click the Event Log tab.

The Event log file area displays the name and size of the event log, a record of notifications and
events affecting device communications. We recommend keeping the default settings.

e The default File name and full path is: CANform\log\Event.log.
e The default Maximum size of the audit log file is 20 MB.

Place a check mark M in the Enable diagnostic event logging box to log notifications from any
device—not just managed devices—as well as authentication notifications.

Click OK to save changes.

8.3 Server Options - Alarms Tab

Start the Viewer with permission to manage server parameters (see Assigning Users to Groups
on page 84).

Click the Configure Server Options icon at the bottom of the window (or Click Configure >
Server Options).

Click the Alarms tab.

The Maximum viewable alarms box specifies the highest number of alarms—those not yet
closed—that may be displayed in the viewer. The default is 500.

Place a check mark M in the Enable auto-acknowledge box to automatically acknowledge new
alarms with the specified level of severity. If this feature is enabled, choose the level of
severity—Information, Warning, Critical or user-defined levels—in the Severity box.
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e The Alarm Storage features specify criteria for storing and cleaning up alarms in the database.

e Alarms will be deleted from the database automatically after the number of days specified
in the Maximum storage (days) box. The default is 90 days.

e Alarms will be deleted from the database automatically according to the amount of free
space in the database if Enable free space monitoring is checked.

The feature is always enabled (the Enable free space monitoring box is checked but disabled) when the

embedded database is used. For an SQL Server database, place a check mark p to enable the feature (or
remove the check mark to disable it).

Specify the Maximum database size (default is 2,000 MB for the embedded database, 10,000 MB for an
SQL Server database).

Specify the Minimum free space (default is 10%) to use as criteria for deleting records.

e Maintenance alarms may be enabled to alert personnel to scheduled or unscheduled
maintenance for a monitored device. Maintenance alarms may be enabled by clicking on
Configure>Server Options>Alarms or by right-clicking a device in the menu tree. This alarm
may be enabled to have personnel determine whether a device should still be in Maintenance
Mode.

e Maintenance mode alarm interval will repeat the alert at the specified interval, notifying
personnel that the device has been in alarm since the original maintenance date.

e Click OK tosave changes.

8.4 Server Options - SMTP Tab
e Start the Viewer with permission to manage e-mail parameters (see Assigning Users to Groups
on page 84).

¢ Click the Configure Server Options icon at the bottom of the window (or Click Configure >
Server Options).

e Click the SMTP tab to specify SMTP mail servers for e-mail notifications.
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Figure 8.1 Add SMTP mail servers

Server Options SMTP Server B
General | Event log | Alarms | SMTP | Device | SNMP | Velocity protocol | Trap forward

Name:

SMTP servers

Description:
Name Description

Hostname or IP address:

P port SMTP server authentication
© Use standard port (25) 587 [v] This server requires authentication
) Use custom port: ser name:

issword:

[¥] This server requires a secure connection

iterthe e-mail address to be used as the 'sender’ | fall e-mails. This account will receive
1y ermor messages generated by the e-mail syster

Automatic :nder’s address:
Sender'saddress:

1

ITEM DESCRIPTION

Check the boxif the server requires a secure connection.

2

Check the box if the you are using Gmail or another SMTP server that requires authentication.

SMTP Servers

To configure a specific SMTP server, click the Add button. The SMTP Server window opens.
In the Name box, enter the name of the server host computer where the software was installed.
If desired, enter text to identify the server in the Description box.
In the Host name or IP address box, specify the outgoing mail server that this computer uses
for outgoing e-mail—for example, mail.company.com or 192.168.0.18.
The Port number box displays the IP port to be used as the SMTP port.

e The default is Use standard port (25), the most commonly used port.

e 587 acommonly used port for sending e-mail messages to an SMTP server, is also
available.

o Ifadifferent portis used, click Use custom port, then choose a number from the list.

In the Sender’s address box, enter the e-mail address to use for all outgoing e-mail
notifications—for example, Support@company.com.

Any error messages from the e-mail system will be sent to this address.

If using Gmail or another SMTP server requiring authentication:

e Putacheckin the box for This server requires authentication and enter the user name
and password.

Click OK toreturn to the Server Options window.
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Automatic
e |[fdesired, enter an e-mail address in the Sender’s Address text box.

This is required if you wish to choose the automatic server option for an e-mail action (see
Configure E-Mail Actions on page 71), determining the recipient's SMTP server based on the
domain name. An Nform server with Internet access will send notifications directly to the
recipient’s mail server, requiring no additional configuration and allowing for faster delivery.

NOTE: This address must be entered before the automatic server option may be used.

Save Changes
e Click OK in the Server Options window to save changes.

8.5 Server Options - Device Tab

Start the Viewer (see Assigning Users to Groups on page 84 for access privileges).

e Click the Configure Server Options icon at the bottom of the window (or Click the Configure
menu, then choose Server Options).

e Click the Device tab.

e Global status polling options require permission to manage global device parameters (see
Assigning Users to Groups on page 84).

Choose an option to enable or disable global status polling. The option chosen to poll managed
devices for communication and alarm status will apply to all devices. If polling is enabled
globally, it may be disabled for individual devices (see Communications Tab on page 50).

e Priority: All devices will be polled according to a specified priority, either High or Low
(default). The high or low priority may be changed for individual devices.

e Daily: All devices will be polled at a specified time every day. Specify the time of day using
a 24-hour clock in the format hh:mm—for example, 09:30 for 9:30 a.m. or 13:15 for 115 p.m.

e Interval: All devices will be polled at a specified interval. Specify the time interval in
hours—for example, approximately every 2 hours or every 8 hours.

e Disabled: No devices will be polled. This option may not be changed for individual devices.

e The Data Logging Storage features require permission to manage logging parameters (see
Assigning Users to Groups on page 84.).
Data logging requires a license with Advanced Communications (see Ordering Parts and

Licenses From Vertiv on page 129).

Two types of criteria may be specified for storing and cleaning up logged data:

e Data will be deleted from the database automatically after the number of days specified in
the Maximum storage (days) box. The default is 180 days.
e Data will be deleted from the database automatically according to the amount of free
space in the database if Enable free space monitoring is checked.
The feature is always enabled (the Enable free space monitoring box is checked but disabled) when the
embedded database is used. For an SQL Server database, place a check mark I to enable the feature (or
remove the check mark to disable it).
Specify the Maximum database size (default is 2,000 MB for the embedded database, 10,000 MB for an
SQL Server database).
Specify the Minimum free space (default is 10%) to use as criteria for deleting records.

e Click OKtosave changes.
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8.6 Server Options - SNMP Tab

The SNMP tab specifies global settings for trap ports, community strings and the log-in user name and
password for Web cards. All but the trap receive port may be overridden for individual devices.

e Start the Viewer with permission to manage global device parameters (see Assigning Users to
Groups on page 84).

¢ Click the Configure Server Options icon at the bottom of the window (or Click the Configure
menu, then choose Server Options).

e Clickthe SNMP tab.
e The Trap receive port box displays the trap port to be used by the server to receive traps.
e Thedefault is Use standard port (162), the most commonly used port.

e Tospecify another port, click Use custom port and choose a number from the drop-down
list.

e Inthe Web card log-in section, enter the User name and Password to be used globally for all
devices. The default is Liebert for both user name and password (the passwords will be hidden
when entered).

e Inthe Global values section, enter request and trap community strings to be used by all
devices. In most cases, these will be the same. The defaults are:

e Request community: public (The request community string is case-sensitive and must
match the community string entered in the SNMP card.)

e Trap community: public (The trap community string is case-sensitive and must match
the community string entered in the SNMP card.)

e The Timeout box designates the number of seconds for a device to respond to an SNMP query.
The default is 1000 milliseconds; We suggest that this value is appropriate in most cases. (If you
receive an excessive number of timeout error messages, consider increasing the time.)

e The Retries box specifies the number of times to attempt polling a device for an SNMP query
after noresponse. The default is 2.

e TheRequest port box displays the port to be used by the server to request traps.
e Thedefault is Use standard port (161), the most commonly used port.

e Tospecify another port, click Use custom port and choose a number from the drop-down
list.

e Click OK to save changes.
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8.6.1 Server Options - SNMP Tab - SNMPv3

Liebert Nform supports SNMPv3 for devices that utilize the SHAT or MD5 authentication protocols and
the DES privacy protocol. Settings in the SNMPv3 portion of the SNMP tab will apply to all managed
devices configured to use SNMPv3 (refer to Protocol Tab - SNMP on page 51.

NOTE: Liebert Nform permits only one set of credentials for accessing SNMPv3 devices. The system
administrator should store the user name and keys in a place accessible by all personnel authorized to
access the SNMPv3 devices.

NOTE: Because of the high consumption of resources with SNMPv3 encryption and decryption, we
recommend that you use a high-performance server and that you reduce the data-logging interval. In
addition, we recommend that you decrease the time-out and retries settings for SNMP properties, see
Server Options - SMTP Tab on page 39.

NOTE: Because of encryption limits at this time, Nform cannot auto-discover SNMPv3 devices.

In the SNMPv3 parameters box, enter the settings for accessing SNMPv3 devices. The user name, as well
as the pass phrase(s), must match one of the accounts in each of the devices on which SNMPv3 will be
employed. The user name and passphrase(s) must first be configured in each device that isto use
SNMPv3. For information on configuring the account, refer to the user manual of the card in the device.

e Inthe User (security) name box, enter a name to use when accessing SNMPv3 devices.

The user name can be as short as one character. Leave this blank if SNMPv3 will not be
enabled.

e Choose an Authentication protocol to be used. The default is None; options are SHA-1and
MD5.

If Authentication protocol is set to None, the Privacy protocol will not be available. Using the
Authentication protocol does not require that the Privacy protocol be used.

e Enter an Authentication key. The key must have at least eight characters and no more than
64.

Record this key and store it in a secure area where it can be retrieved.

e Choose a Privacy protocol to be used. The default is None; the only option is DES.
The Privacy protocol will not be available if Authentication protocol is set to None.

e Enter a Privacy key. The key must have at least eight characters and no more than 64.
Record this key and store it in a secure area where it can be retrieved.

e Click OK to save your changes.
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8.7 Server Options - Velocity Protocol

The Velocity protocol tab specifies global settings for monitoring and managing devices that support the
protocol. Vertiv™ equipment that accept Liebert IntelliSlot™ cards will communicate over the protocol. The
protocol is enabled by default.

e Start the Viewer with permission to manage global device parameters (see Assigning Users to
Groups on page 84).

¢ Click the Configure Server Options icon at the bottom of the window (or Click the Configure
menu, then choose Server Options).

e Click the Velocity protocol tab.
e The Enable Velocity Protocol option requires permission to manage server parameters (see
Assigning Users to Groups on page 84.).

Place a check mark M in this box to use Velocity Protocol for communication with compatible
Vertiv™ devices via Ethernet or IEEE-485 links.

e Specify the settings for all compatible devices or accept the default settings:
e Timeout (msec)—default is 5000 msec
e Retries—defaultis 2

Click OK to save your changes.

8.8 Server Options - Trap Forwarding Tab

Enabling the Trap Forwarding global setting sends all selected types of traps collected by Liebert Nform
to a specified computer. This may be overridden for any particular device with the Enable Trap
Forwarding For This Device check box (see Edit the Device Properties on page 50).

The Trap Forwarding feature is available only in the Nform Enterprise version. The feature differs from the
Forward Trap action, which may be configured to forward individual traps to multiple destinations (see
Configure Forward Trap Actions on page 77 for details).

e Start the Viewer with permission to manage SNMP trap forwarding (see Assigning Users to
Groups on page 84).

¢ Click the Configure Server Options icon at the bottom of the window (or Click the Configure
menu, then choose Server Options).

e Click the Trap Forward tab, which specifies global settings for two features:
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e Trap Forwarding - forward incoming traps to another system:
e Thisfeatureis disabled by default.

To activate, place a check mark M in the Enable box. Even if enabled globally, this feature
may be disabled for individual devices.

e Place acheck mark M in each Types box as needed to select the kinds of traps to forward:
Enterprise
Generic (e.g, cold start)
Authentication

e Inthe Hostname or IP address box, specify the computer where traps should be
forwarded.

e Inthe IP Port box, specify whether to use the standard port 162 (recommended) or a
custom port for this global setting.

e Event Log - log each trap that is forwarded to another system:
e Thisfeatureis disabled by default.

Toactivate, place a check mark M in the Enable trap forward event logging box. Even if
enabled globally, this feature may be disabled for individual devices.

e When finished, click OK to save changes (or Cancel without saving).

8.9 Server Options - Updates Tab

Updates to the Liebert Nform software and updated device support (DTD) files are available to users who
have registered their Nform system for Software Assurance (see Register Product on page 3.

Use the Updates tab to specify whether and when to have Nform automatically check for updates.

Regardless of the settings specified in this window, you may check for updates at any time using the Help
menu to (see Check for Updates on page 96).

e Start the Viewer with permission to manage licenses (see Assigning Users to Groups on page
84).

e Click the Configure Server Options icon at the bottom of the window (or Click the Configure
menu, then choose Server Options).

e Click the Updates tab.

e Choose an option of checking for updates in the Product Updates and DTD Updates sections:
a. Download updates and notify me when finished.
b. Notify me but don't download them (the default).

c. Don't check for updates (see Check for Updates on page 96 to check manually).
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e Specify a schedule in the Check for Updates area for Option a (download) or b (notify):
e Decide how often Nform should check for updates by clicking on:

Click Daily to check for updates every day.

Click Weekly to check for updates once a week, then choose the day of the week (Sunday
through Saturday).

Click Monthly to check for updates once a month, then choose the day of the month
(Tthrough 28—T1 for the first day of the month, 2 for the second, and so on).

e Enter the time of day to check for updates in the Time box (hh:mm using a 24-hour
clock).
e When finished, click OK to save changes (or Cancel without saving).

The Updates Available button, G ,appearsin the Viewer when updates are available. Clicking on this
button opens the Updates Available window (see Check for Updates on page 96).
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9 CONFIGURING DEVICES

This section describes how to configure devices that will be monitored, add floor plans as visual aids, set
up the navigation tree and view or change settings for alarm, trap and SNMP services.

Liebert Nform can monitor and manage any device with a Device Type Definition (DTD); many DTDs are
installed with the application.

If you have purchased a Device Type Definition (DTD) for new equipment from Vertiv™, you must first
install the DTD before the device may be added to the configuration (see Tools Menu - Install DTD on
page 120).

9.1 Add Devices to the Configuration

Three methods are available for adding devices to the Nform configuration. The software can detect
device properties with any of these methods.

Devices may be added:

e by entering the host name or IP address of an individual device (see Add a Single Device on
page 47)

e by entering arange of IP addresses for automatic detection of supported devices on a network
(see Detect Devices on a Network on page 48)

e by importing devices from a file of device properties (see Import Devices From a File on page
56)
9.1.1 Add a Single Device

Devices may be added one at a time.

1. Start the Viewer with permission to configure devices (see Assigning Users to Groups on page
84).

2. Click the Configure Devices icon at the bottom of the window (or click Configure > Devices) to
open the Managed Devices window.

3. Click the Add button to open the Nform Add Devices wizard, shown below right.
4. Click Add a single device.

5. Inthe Add a Single Device window, enter the host name or IP address of the device you wish to
add.

6. Toautomatically detect the description, device type, protocol and other details about the
device, place a check mark M in the Obtain settings from device box.

7. Click Next.

8. The Customize Properties window displays key details for the device.
If you wish to view or make changes to the properties at this time, click the Edit button, then
refer to Edit the Device Properties on page 50. Changes may be made at any time.

9. Click Finish.

10. A message confirms the device was added properly. Click OK, and the Managed Devices
window displays the newly added device.

11. Click Close to return to the viewer.
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9.1.2 Detect Devices on a Network

The auto discovery feature speeds up configuration with automatic detection of multiple devices within a
range of IP addresses on a network.

To use Auto Discovery to detect devices on the network:
1. Start the Viewer with permission to discover new devices (see Assigning Users to Groups on
page 84).

2. Click the Configure Devices icon at the bottom of the window (or click the Configure menu,
then choose Devices) to open the Managed Devices window.

3. Click the Add button to open the Nform Add Devices wizard.
4. Click Discover new devices to add.
5. In the Discover Un-managed Devices window, enter ranges of IP addresses to search:

e Enable - Place a check mark M for each range you wish to search now. Each range
remains available for future searches until removed by clicking the Delete row button.

e Start IP address - Click in the box and enter the lower end of the range—e.g, 198.7162.0.20.
e EndIPaddress - Click in the box and enter the upper end—1798.762.0.30.

Two columns display results from previous searches:

e Not mgd is the number of devices found but not yet added to the Managed Devices list.
e Unknown isthe number of devices found but not currently supported by the software.

6. Click Next to start the Auto Discovery process.
The Search Progress window opens.

7. When the search is complete, the progress bar shows 100%. Click Next.

8. The Add Discovered Devices window shows all supported devices detected during the search.
You may add as many devices as allowed by your license. Review the list and:

e Place acheck mark M next to each device you want to add to the list of managed devices.
Click Select all to add check marks to all devices.

e Remove check marks from devices you do not want to have managed.
Click Clear all to remove all check marks.

e Click the Edit button to view all properties or make changes, then refer to Edit the Device
Properties on page 50. Changes may be made at any time.

9. Click Finish.

10. A message confirms the device was added properly. Click OK, and the Managed Devices
window displays all devices that have been added to the configuration.

11. Click Close toreturn to the viewer.
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9.1.3 Import Devices From a File

This section describes how to use the import option in the Add Devices wizard to import devices from a file
containing device properties.

The file may be generated from the Export Devices feature (see Export Managed Device Configurations
to a File on page 56) or created from a template based on the generated file. An exported file will have a
header line inserted as a comment with an exclamation point (1) at the beginning of the line. It is a good
practice to use header lines in the import files as well. Lines containing device definitions must have
values for the first three fields for each device. Other fields are optional.

Toimport devices from a file:

1.

2.

o W

10.

.

9 Configuring Devices

Start the Viewer with permission to discover new devices (see Assigning Users to Groups on
page 84).

Click the Configure Devices icon at the bottom of the window (or click the Configure menu,
then choose Devices) to open the Managed Devices window.

Click the Add button to open the Nform Add Devices wizard.

Click Import devices from a file to open the Add Device window .

Specify the file to be imported: enter the full path in the File box or click the Browse button to
locate the file, then click Open.

Select the appropriate Delimiter option for the type of delimiter used in the file. The default is
Comma (); other options are Semicolon (), Tab and Tilde (~).

Click Next to begin the import process. If at least one device is imported, proceed to step 8.

If there are errors in an import operation, the same Add Devices window remains open. For more
information, open the text file named DevicelmportErrorstxt in the user sub-directory of the
Nform installation.

The Add Discovered Devices window shows all supported devices detected during the import
operation. You may add as many devices as allowed by your license. Review the list and:

e Place a check mark M next to each device you want to add to the list of managed devices.
Click Select all to add check marks to all devices.

e Remove check marks from devices you do not want to have managed.
Click Clear all to remove all check marks.

e Click the Edit button to view all properties or make changes, then refer to Edit the Device
Properties on page 50. Changes may be made at any time.

Click Finish.

A message confirms the device was added properly. Click OK, and the Managed Devices
window displays all devices that have been added to the configuration.

Click Close to return to the viewer.
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9.2 Edit the Device Properties

Many settings are automatically entered—some from global settings (see Configuring Server Options on
page 37) and some from automatic detection of device settings (see Add Devices to the Configuration on
page 47). Most of these settings may be changed.

To edit the properties of a device:

e Start the Viewer with permission to configure devices (see Assigning Users to Groups on page
84).

e Click the Configure Devices icon at the bottom of the window (or click the Configure menu,
then choose Devices) to open the Managed Devices window. This window is also accessible
from the Edit button from any device window.

e Click the Edit button to open the Device Properties window.
Device Name and Characteristics
e Edit the name and description at the top of the window as needed:

e Name - An identifying name for the device that is displayed in the viewer and may appear
in notifications and logs—for example, UPS_192.168.0.25.

e Description - Additional text to describe the device—e.g, Liebert GXT UPS/Web Card.

e Tochangethetype of device, click in the Device Type list and choose from the supported
devices.

e The Protocol box entry—for example, SNMP—varies according to the type of device selected.

To change this for a custom device, click in the Protocol list and choose from the supported
protocols.

9.2.1 Communications Tab

The Communications tab provides the following options:
e Host name or IP Address
e Foran SNMP device, enter the device’s domain name or IP address; if needed, check with
the System Administrator for that information.
e Foradevice using the Velocity Protocol—for example, the Liebert MPX—via BACnet
router through MSTP (RS-485), enter the address of the BACnet router for this device
(see Protocol Tab - Velocity Protocol on page 52).
e Device has a web server - This box should be checked to allow viewing device information
through a Web browser. The device must have an SNMP card that supports a Web interface.
e URI- Leave this box blank (default) to use the device’s host name or IP address to access the
Web interface. To override this, enter an alternate address in this box.
e Test - Click this button to connect to the device via the Web interface.
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GLOBAL OPTION OPTIONS FOR CUSTOMIZING INDIVIDUAL DEVICES

Status polling - Options vary depending on the choice made in Server Options - Device Tab on

page 41, as shown below. The options for individual devices may be customized as follows:

High - device willbe polled approximately every 2 to 5 seconds *
Priority Low (default) - device will be polled approximately every 20 seconds *
Disabled - no polling willoccur for this device
I Disabled - no polling willoccur for this device
Dally
If enabled, all devices will be polled at the same specified time each day
Disabled - no polling willoccur for this device
Interval
If enabled, all devices will be polled at the same specified interval
Disabled None—this option disables the polling option for all devices
(to change polling for an individual device, the global option must be changed)
*The polling interval for high or low priority varies by the total number of devices

Enable trap forwarding for this device - Place a check mark M to activate this feature (available

only in the Nform Enterprise version).

Timeout and Retries: The global values will be used by default. To change this, place a check
mark M in the Override Global Value check box, then enter values for this device in the
Timeout and Retries boxes (see Server Options - SNMP Tab on page 42).

9.2.2 Protocol Tab - SNMP

If the communication protocol for the device is SNMP, the SNMP tab provides the following options:

OPTION NOTES

The default is Use global port (161), the most commonly used port.

P bort The IP port corresponds to the Request port in the Server Options global settings (see Server Options - SNMP Tab on

P page 42).

To specify adifferent port, click Use custom port and choose a number from the drop-down list.
For devices that support newer versions of SNMP, this option provides a way to select the SNMP version for a specific
device—for example, from SNMPV2c to SNMPvI—to help troubleshoot communication problems with the device.
SNMPV1—unencrypted protocol

SNMP SNMPv2¢c—unencrypted protocol

version
SNMPv3—protocol that can use authentication and be encrypted
Only devices that are capable of SNMPv3 communication will have the SNMPV3 choice shown. If SNMPV3 parameters
have been configured, then that choice may be selected here to use v3 communication with the device (refer to
Server Options - SNMP Tab - SNMPV3 on page 43).

Request ) ) .

community The global value displayed below the text box (see Server Options - SNMP Tab on page 42) will be used by default.

- To change this value, place acheck mark [ in the Override Global Value check box and enter anew value in the text

rap box.
community

9 Configuring Devices
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9.2.3 Protocol Tab - Velocity Protocol

If the communication protocol for the device is Velocity protocol, the Velocity Protocol tab provides the
following options:
e [fusing the Velocity Protocol via BACnet router through MSTP (RS-485):

e Click to place a check mark M in the Device is serial via BACnet router box. By default, this
setting is disabled.

e Enter a numberinthe MSTP Network box to indicate the network number.

e Enteranumberinthe MSTP Node box to specify the node where the device is
connected.

e Click the Communications tab, then enter the address of the BACnet router for this
device in the Host name or IP Address box (see Communications Tab on page 50).

9.2.4 Liebert RSD Tab

The Liebert RSD tab appears only when the Global Setting for Liebert RSD is activated (see Server
Options - General Tab on page 37), and provides the following options:

e Tooverride the global setting for this device:
e Click to place a check mark M in the Override Global Value box.
e Enter a different string in the text box below the Override Global Value box.

e Enterastring in the Device Tag box. This value is assigned by Liebert Services for devices that
are covered by a Liebert Services contract.

9.2.5 Info Links

You may define a link to a Web page or a file for a device, an area or a logical group. These links are
accessible in the Navigate tab (see Navigate - Info Links View on page 107).

To open the Information Links window for:

e Devices: Click Info Links in the Device Properties window.
e Areas: Click Info Links in the Area Properties window. See Add or Edit an Area on page 60.

e Logical Groups: Click Info Links in the Group Properties window. See Group Properties - Logical
Groups on page 65.

Permanent links—gathered during Auto Discovery of devices—may not be edited or deleted.

To add a user-defined link

o Click the Add button to access the Link details area.
e Enter a descriptive name for the link in the Name box.
e Enterthe full link in the URI box (e.g., www.vertivco.com or c:\text.txt).

e Click the Test button to verify the designated Web page or file opens.
e Click the Save button. The link appears under the heading User-defined.

To change a user-defined link:

e Clickthelink toselect it.
e Click the Edit button, then make changes as needed.
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Click the Save button.

Toremove a user-defined link, click the link, then click the Delete button.

Click OK to save changes and close the window (or Cancel to close without saving).

9.2.6 Device-properties Alarms tab

To view or change the name or severity level of alarms for this device:

Start the Viewer with permission to edit device definitions (see Assigning Users to Groups on
page 84).

Click the Alarms and Data button in the Device Properties window to open the Device Alarms
and Data window, then click the Alarms tab to view all system-defined alarms for this device.

Tochange a name, click an alarm at the top of the window, then enter text in the Name box in
the User-Defined section in the lower right corner of the dialog.

Tochange the severity, click an alarm, then choose from the Severity list—e.g, Warning.

Click Commit to save these changes and keep the window open.

When finished, click OK to save all changes and close the window. (Or click Cancel to close
without saving changes.)

The next time the window is opened, a check mark appears to the left of a System-Defined
Name that has been redefined; the User-Defined Name column displays the new name.

9.2.7 Device-properties Data Tab

To view or change the name of data items for this device:

Start the Viewer with permission to edit device definitions (see Assigning Users to Groups on
page 84).

Click the Alarms and Data button in the Device Properties window to open the Device Alarms
and Data window, then click the Data tab to view all system-defined data points for this device.

Tochange aname, click a data point at the top of the window, then enter text in the Name box
in the User-Defined section in the lower right corner of the dialog.

Click Commit to save these changes and keep the window open.

When finished, click OK to save all changes and close the window. (Or click Cancel to close
without saving changes.)

The next time the window is opened, a check mark appears to the left of a System-Defined
Name that has been redefined; the User-Defined Name column displays the new name.

9.2.8 Data Logging

NOTE: This feature requires a license with Advanced Communications (see Ordering Parts and
Licenses From Vertiv on page 129).

Data logging may be used to collect real-time data continuously at fixed intervals to track the condition of

a device.

This time-based feature differs from the event-based Read Data action, which may be used to collect real-
time data after being triggered by an event (see Configure Read Data Actions on page 78).

9 Configuring Devices
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Both features collect the same type of data, which may be viewed in a trend graph (see Navigate - Trends
View on page 106) or exported to a text file (see Export Data Log History on page 9.

ltems selected for data logging will have a check mark in the Log column in the Device Data Logging
window, and the Trend Data Selection window (see Navigate - Trends View on page 106).

To view or change the items selected for data logging for this device:

e Start the Viewer with permission to configure data logging (see Assigning Users to Groups on
page 84).

e Click the Data Logging button in the Device Properties window to open the Device Data
Logging window.

e Each dataitem appears with its name, units of measurement and a brief description. Use the
Log check boxes to choose which data items to log:

e Click to place a check mark M to the left of any data item. (Click again to remove a check
mark.)

e Click the Select all button to check all items.
e Click Clear all to remove all check marks.

¢ Inthe Sampling Interval (minutes) box, specify how often to collect readings of the selected
data items from the device.

e When finished, click OK.

9.3 Maintenance Mode

Devices may be placed in maintenance mode, which prevents device-related alarms from triggering
configured actions, including user notifications. Alarms are logged (see Informational Icons in the
Navigation Tree on page 111, but will not generate actions or notify users. Devices may be placed in
maintenance mode—manually or at a scheduled time—or returned to normal.

When a device is in maintenance mode, the images in the navigation view will change from statusicons to

maintenance icons:

e Infloor plans, the maintenance icons, jt‘ ,indicate that devices are in maintenance mode.

e Innavigation tree, a smaller version of the maintenance icon ti appears next to the device
name. For details about statusicons, see Informational Icons in the Navigation Tree on page 111.
9.3.1 Shortcuts to Place Devices Into or Out of Maintenance Mode

e Inthe Navigate view, right-click an area to set the Maintenance Mode for all devices in that
area.

e Inthe Navigate view, right-click a single device to set that device alone to maintenance mode.

Vertiv™ | Liebert® Nform™ Installer/User Guide



9.3.2 Configure Maintenance Mode

To configure maintenance mode:

9 Configuring Devices

Start the Viewer with permission to configure devices (see Assigning Users to Groups on page
84).

Click the Configure Devices icon at the bottom of the window (or click Configure > Devices) to
open the Managed Devices window. This window is also accessible from the Edit button from
any device window.

Highlight the devices to configure for Maintenance Mode using shift-click and control-click
methods to select multiple devices.

Click the Maintenance button.
The Device Maintenance window opens.

Choose the type of maintenance mode to apply to selected devices:

e Normal - cancel scheduled maintenance, take devices out of maintenance mode

e Manual maintenance - immediately place devices in maintenance mode

e Scheduled maintenance - specify a time period to place devices in maintenance mode
For the Scheduled maintenance option, specify the time period (required) and a reason
(optional:

e Start Date - choose the date (yyyy-mm-dd) and time (hh-mm using a 24-hour clock)

e Specify the ending time by choosing either of the following options. If you enter an End

Date, the Duration is automatically adjusted; if you enter the Duration, the End Date is
adjusted.

End Date—choose the date (yyyy-mm-dd) and time (hh-mm using a 24-hour clock) or

Duration—specify the length of the time period in minutes.

e Reason—enter descriptive text to help identify the purpose of the scheduled
maintenance. This text will be copied to the Incident field in the alarm log for any alarm
that occurs while the device is in maintenance mode. This applies only to scheduled
maintenance.

Maintenance Alarm - click check Override global value to enable the Maintenance alarm. This
lets Nform alert personnel that maintenance is being performed on a particular device.

Alarm interval - specify a time interval for an alert to remind personnel that a device has been
in maintenance mode since the Start date specified. Action sets may be mapped to this alarm
as with any other alarm. See Map Action Sets to Devices and Alarms on page 81 for more
information.

When finished, click OK.
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9.3.3 Import Devices From a File

This section describes how to use the import option in the Add Devices wizard to import devices from a file
containing device properties.

The file may be generated from the Export Devices feature (see Export Managed Device Configurations
to a File on page 56) or created from a template based on the generated file. An exported file will have a
header line inserted as a comment with an exclamation point (1) at the beginning of the line. It is a good
practice to use header lines in the import files as well. Lines containing device definitions must have
values for the first three fields for each device. Other fields are optional.

Toimport devices from a file:

1. Start the Viewer with permission to discover new devices (see Assigning Users to Groups on
page 84).

2. Click the Configure Devices icon at the bottom of the window (or click the Configure menu,

then choose Devices) to open the Managed Devices window.

Click the Add button to open the Nform Add Devices wizard.

Click Import devices from a file to open the Add Device window .

Specify the file to be imported: enter the full path in the File box or click the Browse button to

locate the file, then click Open.

6. Select the appropriate Delimiter option for the type of delimiter used in the file. The default is
Comma (); other options are Semicolon (), Tab and Tilde (~).

7. Click Next to begin the import process. If at least one device is imported, proceed to step 8.
If there are errors in an import operation, the same Add Devices window remains open. For more
information, open the text file named DevicelmportErrorstxt in the user sub-directory of the
Nform installation.

o W

8. The Add Discovered Devices window shows all supported devices detected during the import
operation. You may add as many devices as allowed by your license. Review the list and:

e Place acheck mark M next to each device you want to add to the list of managed devices.
Click Select all to add check marks to all devices.

e Remove check marks from devices you do not want to have managed.
Click Clear all to remove all check marks.

e Click the Edit button to view all properties or make changes, then refer to Edit the Device
Properties on page 50. Changes may be made at any time.

9. Click Finish.

10. A message confirms the device was added properly. Click OK, and the Managed Devices
window displays all devices that have been added to the configuration.

11. Click Close to return to the viewer.

9.4 Export Managed Device Configurations to a File

This feature allows you to export the basic configuration information for selected managed devices to a
field-delimited text file that may be imported back into the same or another Nform configuration or into a
spreadsheet. The delimiter may be a comma, semicolon, tab or tilde.

The generated file may be used as a template to create devices, as long as the same format is used. The

first line contains field names in a comment line beginning with an exclamation point (. The first three
fields must contain data for each device. Other fields are optional.
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To export managed device configurations to a file:

9 Configuring Devices

Start the Viewer with permission to configure devices (see Assigning Users to Groups on page
84).

Click the Configure Devices icon at the bottom of the window (or click the Configure menu,
then choose Devices) to open the Managed Devices window. This window is also accessible
from the Edit button from any device window.

Highlight the devices to export using shift-click and control-click methods to select multiple
devices.

Click the Export button.

The Export Devices window opens.

Specify the file to be created: enter the full path and file name in the File box or click the
Browse button to locate the folder, then enter a file name and click Open.

Select the preferred Delimiter option to be used in the file. The default is Comma (); other
options are Semicolon (), Tab and Tilde ().

Click Export to begin the export process. When the process is complete, a window displays a
message that the export operation was successful or had errors.

57



This page intentionally left blank

58 Vertiv™| Liebert® Nform™ Installer/User Guide



10 CONFIGURING VIEWS FOR THE NAVIGATE TAB

The view in the Navigate tab may be customized to create views for different users, organize devices into
groups or add graphic floor plans as visual reminders of where devices are located. See Navigate Tab -
Device on page 104 for details.

A default view called All Devices is created automatically, then altered as devices are added to or deleted
from the Managed Devices list. Areas may be added and devices rearranged in the All Devices view as in
any other view, but the All Devices view may not be deleted.

To configure views:

e Start the Viewer with permission to configure navigation views (see Assigning Users to Groups
on page 84).

e Click the Configure menu, then choose Views.

e The Navigation Views window displays the default All Devices view and any other configured
Views.

e Optionsin this window include:

Add to create a view - see Add or Edit Views on page 59.

Copy to create a new view based on a selected view - see Add or Edit Views on page 59.
Edit to make changes to an existing view - see Add or Edit Views on page 59.

Delete to remove a view from the list - see Add or Edit Views on page 59.

Logical groups: for details, refer to Create Logical Groups on page 64.

10.1 Add or Edit Views

Tocreate or edit a customized view:

1. Start the Viewer with permission to configure navigation views (see Assigning Users to Groups
on page 84).

2. Click the Configure menu, then choose Views to open the Navigation Views window.

Choose one of these options (All Devices is automatically generated from devices added to the
Managed Devices list—it may be edited with a new name or copied, but not deleted):

Click Add to create a new view.
Click an existing view, then click Edit to make changes to the selected view.
Click an existing view, then click Copy to create a new view based on the selected view.

Click Delete to remove a view. This button is disabled when the All Devices view is
selected.
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4.

In the Navigation View Properties window,

Enter a short name in the Name box that will appear in the Navigation Views window.
In the Description box, enter additional text to identify the view, if desired.
The Navigation View Tree shows how devices will appear in the Navigation view.

The Available Devices list at right shows all devices that have not been assigned to the
tree.

Use standard shift-click and control-click methods to select multiple items.
To move devices between the Navigation View Tree and the Available Devices list:

a. Select one or more items, then drag-and-drop to the desired location.

b. Another method is to select items, then use the left and right arrows on the screen.

To move items up or down in the tree at left:
Select one or more items, then drag-and-drop to the desired location.
Another method is to select items, then use the up or down arrows on the screen.

Toadd an area tothe tree, proceed to Place Devices in Floor Plans on page 61.

5. Besuretoclick OK to save changes (or click Cancel to close the window without saving).

10.2 Add or Edit an Area

Toadd or edit an area in the navigation view:

1.

Start the Viewer with permission to configure navigation views (see Assigning Users to Groups
on page 84).

Click the Configure menu, then choose Views to open the Navigation Views window.

Open the Navigation View Properties window (see Add or Edit Views on page 59).

Choose one of these options to open the Area Properties window:

Click Add to create a new area.
Click an existing area, then click Edit to make changes to the selected area.
Click an existing area, then click Copy to create a new view based on the selected area.
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5.

In the Area Properties window:

Enter a short name in the Name box that will appear in the Navigation view—e.g., AreaD.

In the Description box, enter additional text to help identify the area.
Add an Image to an Area (Optional)

Toadd an image such as a floor plan to the area, enter the full path and file name of the
graphic file or click the Import image button in the Locator Map section to locate the file.
Refer also to Place Devices in Floor Plans on page 61.

A copy of the imported graphic file will be placed in the locatormap folder, a subfolder of
the user folder in the Nform application folder.

Contact Vertiv™ for custom-built floor plans—or create a floor plan.
Floor plans may be standard bitmap (jpg, gif, bmp, png, tiff, exif) or metafile (emf, wmf) format.

Add a Link to a Web Page or File (OptionaD

Toadd alink to a Web page or filg, click the Info Links button (see Info Links on page 52).

Click OK to close the Area Properties window.
Be sure to click OK in the Navigation View Properties window to save the changes.

6. Move devices to areas as needed (see Add or Edit Views on page 59).
7. Toremove an area from the tree, Click the area, then click Delete.

8. Click OKin the Navigation View Properties window to save the changes.

10.3 Place Devices in Floor Plans

After adding a floor plan image to an area window (see Add or Edit an Area on page 60), to place a device
in a floor plan map:

1.

w

Start the Viewer with permission to configure navigation views (see Assigning Users to Groups
on page 84).

Click the Configure menu, then choose Views to open the Navigation Views window.
Open the Navigation View Properties window (see Add or Edit Views on page 59).

In the Navigation View Tree, Click an area with a floor plan image, then Click the Floorplan
button.

In the Floorplan Properties window:

All devices that have been added to this area appear at the top of the window as status
icons.

Click-and-drag icons to any location on the floor plan.
Use the Image Size slider bar to make all icons larger or smaller.
Place a check mark M in the Show Labels box to reveal all device names.

Labels may be moved all at once using the Default Label Position buttons: Above, Below,
Left or Right. To move an individual label, click-and-drag the label to any position on the
floor plan. When manually repositioned, labels keep the same position relative to their
icons even if the icon is moved or the Default Label Position is changed for all labels.
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Figure 10.1 Positioning device icons
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6. Right-Click an area in the floor plan that does not have a label for a pop-up menu with
additional options that affect all labels for icons in this floor plan.
The options are:
o Default Label Properties - click to open the Label Properties window (see Step 8) to
specify properties for all labels that have not been customized, as described in Step 7.
e Reset All Label Properties - revert to the default properties for all labels that have been
customized.
e Reset All Label Positions - revert to the default position for all customized labels.

Figure 10.2 Right-click options for floor-plan labels
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9.

10.

Right-Click an individual label for a pop-up menu with additional options that affect only the
selected label. The options are:

e Label Properties - click to open the Label Properties window (see Step 8) to customize
properties for this label only.

e Reset Label Properties - revert to the default properties for this label.
e Reset Label Position - revert to the default position for this label.

The Label Properties window is accessible by right-clicking on the floor plan outside labels
(Step 6) or on an individual label (Step 7).

e Click the Font Options button to change the font, style and size in a standard Font
window.

e Place a check mark M in the Show Border box to draw a border around label text.

e Click Foreground Color to open a Color window and change the label text color.

e Click Background Color to open a Color window and change the label background color.
Click OK to save changes (or Cancel to close the window without saving).

Click OK in the Navigation View Properties window. A window displays a message that the
configuration has changed and the session will be restarted.

10.4 Create Logical Groups

NOTE: In this release of the Liebert Nform software, logical groups apply only to Liebert MPX and
Liebert MPH devices. Logical group features will be hidden or disabled if the list of managed devices
has no Liebert MPX or Liebert MPH devices.

Logical groups may be used to configure Liebert Rack PDUs—Liebert MPX and Liebert MPH devices—
using a hierarchical structure starting at the PDU level, down to the branch and receptacle levels.

The status of various components may be viewed—for example, power and current, as shown
below.

Control functions are also available, as shown in the example below: receptacles may be turned
on and off individually and in groups through the Liebert Nform software.
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Figure 10.3 Logical groups in the navigation tree
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To create a logical group:

© N o o

Start the Viewer with permission to configure navigation views (see Assigning Users to Groups
on page 84).

Click the Configure menu, then choose Views.
Click the Logical groups button.

The Logical Group Properties window displays a tree at left and available modules at right.
Choose one of these options to open the Group Properties window:

e Click Add to create a new logical group.
e Click an existing group, then click Edit to make changes to the selected group.
e Click an existing group, then click Copy to create a new group based on the selected
group.
Toadd or edit a logical group, see Group Properties - Logical Groups on page 65.
Toremove a group from the tree, Click the group, then click Delete.
To move a group in the treg, Click the group, then use the up and down arrows in the center.
Click OK to save changes.

10.4.1 Group Properties - Logical Groups

To open the Group Properties window, see Create Logical Groups on page 64.

Enter a short name in the Name box that will appear in the Navigation view—e.g,, Group.

In the Description box, enter additional text to help identify the logical group, if desired.
Toadd a link toa Web page or filg, click the Info Links button (see Info Links on page 52).
Click OK to close the window.

Be sure to click OK in the Logical Group Properties window to save the changes.
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11 CONFIGURING SHUTDOWN CLIENTS

NOTE: This feature requires Vertiv™ or a third-party shut-down software.

This section describes how to configure shutdown client computers so they may be selected for
shutdown actions (see Configure Shutdown Actions on page 76).

Before adding shutdown clients:

e The shut-down software must be installed on all workstations and servers that require orderly
shutdown.

e Anyrequired license is installed on the Nform server.

To configure shutdown clients:

e Start the Viewer with permission to manage shutdown clients (see Assigning Users to Groups
on page 84).

¢ Click the Configure menu, then choose Shutdown Clients.

e The Shutdown Clients window displays all configured clients. Options in this window include:
e Add tocreate a shutdown client: for details, refer to Add a Shutdown Client on page 66.
e Copy tocreate anew client based on the selected client.
e Edit to make changesto an existing client.
e Delete toremove a client from the list.

e Onceclients are configured, use the Test to send a test message to an existing client.

e Click toselect a client from the list. Multiple selections are allowed using the standard
shift-click and control-click methods.

e Clickthe Test button to send a test message to each selected client’s IP address or host
name.

e Adialog box confirms whether the test message was sent. Also verify that each client
computer received the message.

1.1 Add a Shutdown Client

To add a shutdown client:

1. Start the Viewer with permission to manage shutdown clients (see Assigning Users to Groups
on page 84).

2. Click the Configure > Shutdown Clients.

3. Inthe Shutdown Clients window, click the Add button. The Shutdown Client Properties window
opens.

4. In the Name box, enter an identifying name for the client computer.
This name will appear in lists of configured clients that can be selected for shutdown actions.

5. Inthe Description box, enter text to describe the client computer, if desired.

In the Client Type box, select the type of shut-down software client.

7. Inthe Hostname or IP Address box, enter the client computer’s IP address or host name,
available from the System Administrator.

<}
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8. The IP Port designates the port used for communicating events (traps) with two options:
e Use standard port (162)
e Use custom port (3029)

The following table shows typical port combinations.

SNMP TRAPLISTENPORT = SNMP SEND REQUEST PORT

Shut-down software | 3029 3027

Standard SNMP 162 161

9. Enter astring in the default Trap Community.

10. Click OK.

1. Continue adding workstations that are running the shut-down software, then proceed to
Configure Shutdown Actions on page 76.
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12 CONFIGURING ACTIONS

This section describes how to configure Liebert Nform to respond to events and alarms, such as:

e E-mail: sending e-mails to selected recipients when an alarm is received

e Runcommand:running an external program to protect data or equipment

e Writefile:launching a command or batch file that can execute user-customized scripts

e Shutdown: configuring graceful shutdown of client computers running shut-down software.
e Forward trap: sending traps received to a specific computer (host name or IP address)

e Read data: collecting samples of data points from selected managed devices

o Write data: changing values of selected data points based on specified alarms or events

Configuring actions enables Liebert Nform to protect valuable equipment, data and other assets from
such events as power failures, overheating and mechanical failures.

12.1 Configuring Actions - Overview
Setting up actions involves three steps, as shown in the example below:

1. Create an action set—a named group of individual actions (see Configure an Action Set on
page 70).

2. Add individual actions to the action set from a list: E-mail, Run command, Write file, Shutdown,
Forward trap, Read data or Write data (see Configure an Action Set on page 70).
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3. Link action sets to managed devices (see Map Action Sets to Devices and Alarms on page 87).

Any action set can be linked to any configured devices, and the diagram shows 2 examples.

Figure 11.1 Example action configurations

[ —Q0B

—RER

3

ITEM DESCRIPTION

1

Create anamed group of individual actions, the Action Set

Add actions to the set, for example: send e-mail(s), run commands, write files, shutdown, forward trap, read and
write data.

Link the action sets to devices.

12.2 Configure an Action Set

To create an action set:

1.

w

<}

Start the Viewer with permission to configure at least one type of action (see Assigning Users
to Groups on page 84).

Click the Configure Actions icon at the bottom of the window (or click the Configure menu,
then choose Actions).

In the Action Sets window, click the Add button.

In the Name box, enter an identifying name for the action set.

This name will appear in lists of action sets that can be assigned to events.

In the Description box, enter text to describe the action, if desired.

Click the Add button to create an action toinclude in this action set.

In the Select Action Type window, above right, click the type of action you wish to create: Email,
Run command, Write file, Shutdown, Forward trap, Read data or Write data.
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8. Createindividual actions to include in this action set, referring to the following sections:
e Configure E-Mail Actions on page 71 for customized e-mail messages to selected
recipients
e Configure Run Command Actions on page 74 to launch scripts when alarms are received
o Configure Write File Actions on page 75 to record alarm information in a file
e Configure Shutdown Actions on page 76 for graceful shutdown of computers running
shut-down software.
e Configure Forward Trap Actions on page 77 to send traps to a specific computer
e Configure Read Data Actions on page 78 to collect samples of data points from a device
e Configure Write Data Actions on page 79 to change values of selected data points based
on specified alarms or events
9. Each time an action is added, the Action Set Properties window reappears and displays the
new action. ltems in the Actions list may be moved, changed or removed:
e Tomove an action up or down in the list, click the name, then click the Up or Down arrow.
e Tochange an action’s properties, click the name, then click the Edit button and make
changes.
e Toremove an action from the list, click the name, then click the Delete button.
10. The Execute sequentially box in the Execution section specifies whether actions in this set will
run in parallel (default, not checked) or sequentially in the order displayed in the Actions list.
To choose the sequential method:
e Place acheck mark M in the Execute sequentially box.
e Specify what to doif an action fails during execution:

- To proceed executing all remaining actions after an action fails, place a check mark M in
the Continue execution if an action fails box.

- Tointerrupt the execution and skip remaining actions, remove the check mark.

1. When finished, click the OK button.

12.2.1 Configure E-Mail Actions
To configure an Email action to send an e-mail to selected recipients when an alarm is received:

1. Start the Viewer with permission to configure e-mail actions (see Assigning Users to Groups on
page 84).

2. Open the E-Mail Action Properties window (see Configure an Action Set on page 70).

3. Inthe Name box, enter an identifying name for the action—for example, UPS On Battery. This
name will appear in lists of actions that can be assigned to events.

4. Inthe Description box, enter text to describe the action, if desired—for example, UPS On
Battery.
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5. Inthe To section, enter e-mail addresses of users to receive notifications:

a. Choose from a list of users by clicking the Select button to open the Nform Users
Addresses window, below right. Select e-mail addresses from the list by placing check
marks below the addresses you want to use—Pri. (Primary), Alt. (Alternate), SMS. Click OK.

Addresses are automatically updated for this action when changes are made to any
user’'s email address (see Configuring Users and Groups on page 83).

b. Enter e-mail addresses in the Other recipients’ addresses box, separating each address
with a semicolon () or press the Return key to make a new line.

c. Click the Send Test button to send a generic e-mail to verify that recipients are
configured correctly to receive alarm notifications.
The generic message is sent to all intended recipients with the word test in the subject

and body. A separate error message appears for each attempt that is unsuccessful. Be
sure to check that all e-mails are received.
6. Inthe Subject box, enter a subject for the e-mail by entering text or choosing fields from the
drop-down list to the right of the Subject box.

7. Inthe Message Body box, create a customized message for recipients by entering text or
choosing fields from the drop-down list to the right of the Message Body box (see the following

table).

8. Uncheck Automatically send to recipient’s server if using Gmail or another SMTP server
requiring authentication.

Table 11.1 Substitution fields for e-mail messages

SUBSTITUTION FIELD DESCRIPTION

Substitution Field

Description

Time received (UTC)

Time received (local)

The time when the alarm was received (universal time)

The time when the alarm was received (local time)

Occurred

Source

The elapsed time since the device was last initialized

Where the alarm occurred—e.g., device name or Nform

Device address

Alarm name

The IP address or domain name of the device that sent the alarm

The alarm name—for example, High Temperature or On-Battery

Alarm description

Alarm severity

The alarm description

The severity level of the alarm—for example, Critical

Alarm state The state of the alarm—Active or Cleared

RSD site ID Astring supplied by Liebert Services to identify a group of devices
RSD device tag Astring supplied by Liebert Services to identify a particular device
Alarm ID Anumeric identifier for the alarm’s type

Vertiv™ | Liebert® Nform™ Installer/User Guide



SMTP Server

1. The SMTP Server is the outgoing mail server that will be used to send e-mail notifications.
There are three ways to specify SMTP servers:
a. Specify automatic selection of SMTP servers based on a recipient’s e-mail address. For
this option, put a check mark M in the Automatically send to recipient’s server box.

This option takes very little configuration and can be faster because e-mails are sent
directly to each recipient’s SMTP server based on the domain name.

The automatic option works properly only if an e-mail address is entered in the Sender’s
Address in the SMTP Server window (see Server Options - SMTP Tab on page 39). This
window is available from the button in the E-Mail Action Properties window or the
Configure menu as described in Server Options - SMTP Tab on page 39.

Use the Send Test button to verify the e-mail address is reachable (see step 5Choose
from a list of users by clicking the Select button to open the Nform Users Addresses
window, below right. Select e-mail addresses from the list by placing check marks below
the addresses you want to use—Pri. (Primary), Alt. (Alternate), SMS. Click OK. on page 72
in Configure E-Mail Actions on page 71.

NOTE: If your network security software blocks e-mail sent using the automatic selection option,
contact your network security administrator about whether the policy may be relaxed for your Nform
server machine.

b. Specify a manually configured SMTP server.

To specify a manually configured server, choose that server from the drop-down list.

To specify a server that has not yet been configured, click the Configure button to open the SMTP Server
window (see Figure 112 on the next page, and Server Options - SMTP Tab on page 39). Configure the
server and click OK, then choose that server from the drop-down list.

c. Specify BOTH automatic selection and a manually configured server. If you specify both
and the automatic option fails, the manually configured server will be used as a backup.

2. The Timeout box displays the number of seconds to wait for a valid response if the action fails.
The default is 5 seconds.
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3. Click the Advanced button to open the E-Mail Action Advanced Properties window, see Figure

112 below.

e You may restrict the length of the message to a maximum number of charactersin the
Limit message to box; the default is O, meaning no truncation.

e Message encoding methods may be specified in the Subject encoding and Body
encoding boxes. The default for both is Unicode (UTF-8).

e Click OK to save changes in the E-Mail Action Advanced Properties window.
4. Click OK to save changes in the E-Mail Action Properties window.

Figure 11.2 Configure SMTP Server and Advanced E-mail Properties

Figure 11.3
SMTP Server 8]
Name:
Description:
Hostname or IP address:
1P port SMTP server authentication
@ Use standard port (25) o) 587 ] This server requires authentication
Use custom port: et
Name: Description:
Password:
To————— A e
Nform users:
9] This server requires a secure connection P
Other recipients:
Enter the e-mail address to be used as the ‘sender’ of all e-mails. This account will receive
any error messages generated by the e-mail system.
Wi o g genceed i € kst S .
1 Sender's address: 1
Subject: I I 1
Nform Alarm Notification L a
bl v

SMTP server
[¥] Automatically sendto recipient's s
Configure.... ;

Timeout (sec): 51>

Advanced...

Close Help

Message truncation (0 = no truncation)

Limit messageto (chars):| 0/%

Subject encoding:

[unicode (UTF-8)

Body encoding:

[unicode (UTF-8)

OK Close l [

12.2.2 Configure Run Command Actions

To configure a Run Command action to launch a script when an alarmis received:

1.

Start the Viewer with permission to configure run command actions (see Assigning Users to

Groups on page 84).

Open the Run Command Action Properties window (see Configure an Action Set on page 70).

In the Name box, enter an identifying name for the action. This will appear in lists of actions
that can be assigned to events.

In the Description box, enter text to describe the action, if desired.
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5.

In the File box, enter the full path of the program to be initiated—either type the full path or
use the Browse button to locate the file.

NOTE: The Browse button appears only when using the Viewer on the application server where the full
Nform package is installed; see Installation on page 9.)

6.

In the Command-Line Arguments box, specify arguments—parameters to include in running
the command—by entering text or choosing fields from the drop-down list to the right of the
Command-Line Arguments box (see the following table). These fields will be appended to the
Run command line.

Table 11.2 Substitution fields for command-line arguments

SUBSTITUTION FIELD DESCRIPTION

Time received (UTC)

The time when the alarm was received (universal time)

Time received (local)

Occurred

The time when the alarm was received (local time)

The elapsed time since the device was last initialized

Source

Device address

Where the alarm occurred—e.g., device name or Nform

The IP address or domain name of the device that sent the alarm

Alarm name

Alarm description

The alarm name—for example, High Temperature or On-Battery

The alarm description

Alarm severity

The severity level of the alarm—for example, Critical

Alarm state The state of the alarm—Active or Cleared

RSD site ID Astring supplied by Liebert Services to identify agroup of devices
RSD device tag Astring supplied by Liebert Services to identify a particular device
Alarm ID A numeric identifier for the alarm’s type

7.

8.

The Timeout box displays the number of seconds to wait for a valid response if the action fails.
The default is 5 seconds.

Click OK to save changes.

12.2.3 Configure Write File Actions

To configure a Write File action to record alarm information in a file:

1.

12 Configuring Actions

Start the Viewer with permission to configure write file actions (see Assigning Users to Groups
on page 84).

Open the Write File Action Properties window (see Configure an Action Set on page 70).

In the Name box, enter an identifying name for the action—for example, Critical Alarms. This
will appear in lists of actions that can be assigned to events.

In the Description box, enter text to describe the action, if desired.

In the File box, enter the full path of the file that will record details of events or use the Browse
button to locate the file. (The Browse button appears only when using the Viewer on the
application server where the full Nform package is installed; see Installation on page 9.) If the
file does not exist, Nform will create it.
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6. Inthe Record format box, choose fields to include in the file from the drop-down list to the right
of the Record format box (see the following table).

Table 11.3 Substitution fields for record format

FIELD DESCRIPTION

Time received (UTC) | The time when the alarm was received (universal time)

Time received (local) | The time when the alarm was received (local time)

Occurred The elapsed time since the device was last initialized

Source Where the alarm occurred—e.g., device name or Nform

Device address The IP address or domain name of the device that sent the alarm
Alarm name The alarm name—for example, High Temperature or On-Battery
Alarm description The alarm description

Alarm severity The severity level of the alarm—for example, Critical

Alarm state The state of the alarm—Active or Cleared

RSD Site ID Astring supplied by Liebert Services to identify a group of devices
RSD Device tag A string supplied by Liebert Services to identify a particular device
Alarm ID A numeric identifier for the alarm’s type

7. Enter the upper limit of the file size in MB in the Maximum size box. The default is TMB.
8. Inthe File Open Mode section:

o Click Append to existing file to add data at the end of the file, preventing existing data
from being overwritten by new information.

e Click Create new file to replace the file with each new alarm.
9. Anencoding method may be specified in the File encoding box. The default is Unicode (UTF-
8.
10. The Timeout box displays the number of seconds to wait for a valid response if the action fails.
The default is 5 seconds.
1. Click OK to save changes.

12.2.4 Configure Shutdown Actions

NOTE: This feature requires a computer running shut-down software (see Ordering Parts and
Licenses From Vertiv on page 129).

To configure a Shutdown action:

1. Start the Viewer with permission to configure shutdown actions (see Assigning Users to
Groups on page 84).

2. Open the Shutdown Action Properties window (see Configure an Action Set on page 70).

3. Inthe Name box, enter an identifying name for the action—for example, Shutdown EDI
application server. This will appear in lists of actions that can be assigned to events.

4. Inthe Description box, enter text to describe the action, if desired.
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8.

In the Shutdown Type box, click the appropriate choice:
e |Immediate shutdown - the shutdown will occur as soon as a specified condition occurs.
e Timed shutdown - a timer will begin as soon as a specified condition occurs.

e Cancel pending shutdown - when a specified condition occurs, stop a shutdown that isin
progress.

In the Shutdown Client Selection area:

e Enter any client computers that may be specified for shutdown. If needed, click the
Configure button to set up or choose client computers.

e Place acheck mark M tothe left of any items you wish to select. If desired, click Select All
to choose all items in the list or click Clear All to remove all check marks.

The Timeout box displays the number of seconds to wait for a valid response if the action fails.
The default is 5 seconds.

Click OK to save changes.

12.2.5 Configure Forward Trap Actions

The Forward Trap action may be used to forward individual traps to multiple destinations.

This differs from the global Trap Forwarding setting, which may be used to send all selected types of traps
collected by Liebert Nform to a specified computer (see Server Options - Trap Forwarding Tab on page
44). (Trap Forwarding is available only in Nform Enterprise.)

To configure a Forward Trap action to send traps to one or more computers:

1.

12 Configuring Actions

Start the Viewer with permission to configure forward trap actions (see Assigning Users to
Groups on page 84).

Open the Forward Trap Action Properties window (see Configure an Action Set on page 70).
In the Name box, enter an identifying name for the action—for example, Forward Traps to
IT Manager. This will appear in lists of actions that can be assigned to events.

In the Description box, enter text to describe the action, if desired.

In the Trap Recipients area:

e Specify the computer where traps should be forwarded in the Host name or IP address
column.

e The Port Number displays the default global setting—typically, 162. To change this, enter
a different number.

The Timeout box displays the number of seconds to wait for a valid response if the action fails.
The default is 5 seconds.

Click OK to save changes.
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12.2.6 Configure Read Data Actions

NOTE: This feature requires a license with Advanced Communications (see Ordering Parts and
Licenses From Vertiv on page 129).

The Read Data action may be used to collect real-time data after being triggered by an event.

This event-based feature differs from the time-based Data Logging feature, which may be used to collect
real-time data continuously at fixed intervals to track the condition of a device (see Data Logging on page
53).

Both features collect the same type of data, which may be viewed in a trend graph (see Navigate - Trends
View on page 106) or exported to a text file (see Export Data Log History on page 9.

To configure a Read Data action to collect samples of data points from a device:

1. Start the Viewer with permission to configure read data actions (see Assighing Users to Groups
on page 84).

2. Open the Read Data Action Properties window, see Figure 114 on the facing page (see
Configure an Action Set on page 70).

3. Inthe Name box, enter an identifying name for the action—for example, Read Data Action 1.
This name will appear in lists of actions that can be assigned to events.

4. In the Description box, enter text to describe the action, if desired.

5. Choose a device from the Managed Devices list.

6. The available data points for the selected device appear in the window below the device name,
along with units where appropriate. Click a data point to display an explanation in the
Description box below the list.

7. Click to place a check mark M to the left of each data point you wish to select. Each checked
point appears in the Selected Data Points in the right side of the window.

8. The default Duration of reading data pointsis 5 minutes. If desired, choose a different number
of minutes.
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9. The default Sampling Interval is 30 seconds. If desired, choose a different number of seconds.

10. Click OK to save changes.

Figure 11.4 Read Data Action Properties

Name: Description:

Read-data Actionl Action description

Managed devices

Selected data points
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| 0K | [ Cancel ] [
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ITEM DESCRIPTION

1 Select adevice.
2 Check mark to select data points.
3 The selected data points display in the list.

12.2.7 Configure Write Data Actions

To configure a Write Data action to change values of selected data points based on specified alarms or

events:

1. Start the Viewer with permission to configure write data actions (see Assigning Users to

Groups on page 84).

2. Open the Write Data Action Properties window, Figure 115 on the next page (see Configure an

Action Set on page 70).

3. Inthe Name box, enter an identifying name for the action—for example, Write Data Action 1.

This name will appear in lists of actions that can be assigned to events.
4. Inthe Description box, enter text to describe the action, if desired.

12 Configuring Actions
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5. Choose a device from the Managed Devices list.
The available data points for the selected device appear in the window below the device name,
along with units where appropriate.

6. Click a data point to display an explanation in the Description box below the list.

7. Click to place a check mark M to the left of each data point you wish to select. Each checked
point appears in the Selected Data Points in the right side of the window.

8. If desired, repeat Steps 5 through 7 to choose another device from the Managed Devices list

and select data points for that

device.

The Selected Data Points list at right displays the device name for each data point.

9. For each point in the Selected Data Points at right, enter a figure in the New Value column to
specify the value you wish to write based on a specified condition.

10. The Timeout box displays the number of seconds to wait for a valid response if the action fails.

The default is 5 seconds.
1. Click OK to save changes.

Figure 1.5 Write Data Action Properties
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ITEM DESCRIPTION

1

Select adevice.

2
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Check mark to select the data points.

Enter the new values in the list.
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12.3 Map Action Sets to Devices and Alarms

The final step in configuring actions is to define which alarms will trigger an action set to be executed for
each device. Mapping an action set requires permission to configure all actions in that set. Actions will not
be executed for alarms from a device that is currently in maintenance mode.

Tomap an action set:

1. Start the Viewer with permission to assign actions (see Assigning Users to Groups on page 84).

]
2. Click ) at the bottom of the window (or click Configure > Actions).
3. Inthe Action Sets window, click an action set, then click the Map button, Figure 1.6 below.

Figure 1.6 Action-set Mapping
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ITEM DESCRIPTION

1 Choose an action set.
2 Choose one or more devices.
3 Choose from the alarms that are common to the selected devices, then click Assign.

4. In the Map Actions window:

e Alldevices are displayed in the left side of the window. If desired, choose a device
category—e.g., UPS—from the drop-down list to display only those devices. To further
filter the devices, select Select device types from the drop-down list, to display a list of
devices by manufacturer and model.

e Click a device at left to display all applicable alarms in the right side of the window. (To
select multiple devices, use the standard shift-click or control-click methods.)

e Intheright side of the window, click to select an alarm that will trigger the selected action
set for the selected devices. (To select multiple alarms, use the standard shift-click or
control-click methods)

e Click the Assign button to assign all selected alarms to the selected devices. (To remove
alarms from the mapping, click to select the alarms, then click the Clear button.)

12 Configuring Actions
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5. Mapping status isindicated by:

e Abullet next to a device in the Managed Devices tree at left indicates at least one alarm
has been mapped to that device for the selected action set.

e Inthe Device Alarms grid at right (with one or more devices highlighted for a selected
action set):

Table 11.4 Device-alarm mapping status indicators

BOX APPEARANCE INDICATES

Filled Alarm is mapped to Allselected devices for the action set.
E Half-filed Alarm is mapped to at least one selected device for the action set.
D Empty Alarm is mapped to none of the selected devices for the action set.
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13 CONFIGURING USERS AND GROUPS

The software automatically creates an Administrator account with full access to configuration and
monitoring.

Other individual users may be configured with any combination of viewing and configuration privileges
(see Add Individual Users on page 83). A user may be created with the Add button or based on an
existing user with the Copy button.

Additionally, individual users may be combined into groups with similar privileges (see Assigning Users to
Groups on page 84).

This feature speeds up the process of assigning privileges to many users and allows for easily selecting
many users for actions, such as receiving e-mail alerts.

13.1 Add Individual Users
1. Start the Viewer with permission to configure users (see Assigning Users to Groups on page
84).

2. Click the Configure Users & Groups icon at the bottom of the window (or click the Configure
menu, then choose Users and Groups).
The Users list displays all configured users.

3. Click the Add button to the right of the Users list.
4. In the User Properties window, enter a user name—the name used for login—in the Name box.

NOTE: If you are using Single Sign-on (SSO), you must included the domain in the name field, in the
format: domain\username. See Setting Up Single Sign-on on page 86 to enable SSO.

5. Inthe Full Name box, enter the person’s name or title to help identify the user, if desired.
6. Inthe Description box, enter text to describe the user, if desired.
7. Enter a password in the Password box, then re-enter it in the Confirm Password box.

The password is case-sensitive and must consist of 2 to 14 characters—with any combination
of letters, numerals and symbols. Be sure to record the password in a secure place.

NOTE: If you are using Single Sign-on (SSO), leave the password fields blank. SSO will not work if a
password is entered. See Setting Up Single Sign-on on page 86 to enable SSO.
8. Enter this information about the user for Nform alerts and notifications:
e Pri.e-mail - primary e-mail address
e Alt.e-mail - alternate e-mail address
e SMS e-mail - text message e-mail address
e Phone - telephone number, including area code
e Mobile - cell phone number, including area code
9. If user groups have been created, choose from the Group list to assign the user to a group.

10. Specify the opening view in the Navigate tab for this user by selecting from the Nav. view drop-
down list. The default is All Devices. See Configuring Views for the Navigate Tab on page 59.
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1. Specify whether to activate these features with a check mark ™:
e User must change password at next login - allow users to select their own passwords
e User cannot change password - prevent users from changing passwords
e Account is disabled - deactivate a user account without deleting it

e User cannot change alerts - prevent users from access to the Visual alerts and Audible
alerts tabs in the User Options window

e Auto-logout user after:__min - automatically log the user off after no activity; if checked,
specify the number of minutes in the Min. drop-down list

NOTE: If you are using Single Sign-on (SSO), make sure that "User must change password at next
login" is un-checked. SSO will not work with this feature. Checking any of the other features does not
affect SSO. See Setting Up Single Sign-on on page 86 to enable SSO.

12. Click the User Options button for additional features (see Configuring User Options on page
35).
13. When finished, click the OK button to save changes.

13.2 Assigning Users to Groups

Groups are used to assign permissions to users. Individual users must be assigned to groups that have
specific permissions. This function may also be used to map users to actions such as e-mail alerts.
Changes in this section apply to all usersin the group.

To create a group of users:

1. Start the Viewer with permission to configure groups (see step 3 that follows).

2. Click the Configure Users & Groups icon at the bottom of the window (or Click the Configure
menu, then choose Users and Groups).

3. The Groups list in the lower portion of the window displays all user groups. Click the Add
button to the right of the Groups list.

4. Inthe Group Properties window, enter a name for the group in the Name box.
5. Inthe Description box, enter text to describe the group, if desired.

6. Select privileges by placing a check mark 4 in the box, referring to the table below. Privileges
are logically grouped according to function, but each privilege may be assigned separately.
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Table 121 Summary of group privileges

CATEGORY PRIVILEGE FORDETAILS, SEE:
Manage Configure users Add Individual Users on page 83
Users Configure groups Assigning Users to Groups on page 84 (this section)
Configure devices Add Devices to the Configuration on page 47
Set device data Navigate - Parametrics View on page 105 (Edit option)
Configuring Views for the Navigate Tab on page 59, including:
Add or Edit Views on page 59
Configure navigation views Add or Edit an Area on page 60
Manage Place Devices in Floor Plans on page 61
Devices Create Logical Groups on page 64
Discover new devices' Detect Devices on aNetwork on page 48
Configure datalogging™ Data Logging on page 53
Device-properties Alarms tab on page 53 (both tabs):
Edit device definitions’ Device-properties Alarms tab on page 53
Device-properties Data Tab on page 53
Manage Navigate - Alarms View on page 106
Acknowledge and close alarms
Alarms Managing Alarms on page 110
Mahage Assign actions Map Action Sets to Devices and Alarms on page 81
Actions
E-mail Configure E-Mail Actions on page 71
Run command Configure Run Command Actions on page 74
Write file Configure Write File Actions on page 75
Con_ﬁgure Shutdown® Configure Shutdown Actions on page 76
Actions
Forward trap? Configure Forward Trap Actions on page 77
Read data Configure Read Data Actions on page 78
Write data Configure Write Data Actions on page 79
Server Options - General Tab on page 37 (Locale)
Server parameters Server Options - Alarms Tab on page 38
Server Options - Device Tab on page 41(Velocity Protocol)
Licenses Add a Liebert Nform License Key on page 28
Server Options - Device Tab on page 41(Clobal status polling)
Manage Global device parameters
System Server Options - SNMP Tab on page 42
Email parameters Server Options - SMTP Tab on page 39
Application Menu - Service on page 117
Start/stop server
Tools Menu - Install DTD on page 120
Logging parameters Server Options - General Tab on page 37 (Audit log file)
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Table 121 Summary of group privileges (continued)

CATEGORY PRIVILEGE FORDETAILS, SEE:

Server Options - Event Log Tab on page 38

Server Options - Device Tab on page 41(Datalogging storage?)

SNMP trap forwarding® Server Options - Trap Forwarding Tab on page 44

Shutdown clients* Configuring Shutdown Clients on page 66

1. Selecting this option automatically gives permission to configure devices (Configure devices box is checked & disabled).
2.Requires alicense with Advanced Communications (see Ordering Parts and Licenses From Vertiv on page 1.
3. Requires alicense with Advanced Notifications (see Ordering Parts and Licenses From Vertiv on page 1.

4. Requires ashutdown client license (see Ordering Parts and Licenses From Vertiv on page 1.

7. When finished, click OK to save changes.

13.3 Setting Up Single Sign-on
Single Sign-on (SSO) automatically uses the user credentials of a domain network.

Users are added with domain information in the user name and without a password because they are
already logged-in to the network on which Nform is running (see Add Individual Users on page 83.to set
up SSO users).

Toenable SSO, you must update the Nform configuration files as follows:

1. Open Windows Explorer, browse to C:\Nform\user, and open NformServer.niin a text editor.
e Make sure that word wrap is off in the text editor.

2. Un-comment the lines "EnableSSO="and '[SSO]" by removing the semicolon from the
beginning of the row as shown in the following figure, then save and close the file.

| NformServer.ini - Notepad o &
File Edit Format View Help

; Nformserver.ini . ) .

; Place this in the user subdirectory of the Nform installation.

; Do not delete these files.

1Ns~ [550]
;Setting to enable single sign on (SSO) mechanism. Set the value of following setting to 1 if you want to allow active di
;If you set the value of this setting to 1, then you must configure the value of a setting NformServer in Nformviewer.ini

12,;Enah'le550:1

DESCRIPTION

1 Delete the semi-colon for these lines.
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3. Set the value for the line to EnableSSO=1.
The following figure shows the NformServer.ini file with the correct formatting.

| NformServer.ini - Notepad
File Edit Format View Help
; NformServer.ini 2

; Place this in the user subdirectory of the Nform installation.
; Do not delete these files.

[sso]

Settmg to enable single sign on (SSO) mechanism. Set the value of following setting to 1 if you want to allow active dfi
b)l/ou set the value of this setting to 1, then you must configure the value of a setting NformServer in Nformviewer.ini

Enab1esso=1

< ] | >

4. In same folder, C:\Nform\user, open NformView.ni in a text editor.

5. Un-comment the lines "NformServer ="and "[SSO]" by removing the semicolon from the
beginning of the row as shown in the following figure, then save and close the file.

ﬂNfﬂrmVlewer‘lm—Nmepad o =] &8
File Edit Format View Help

; Nformviewer.ini -
; Place this in the user subdirectory of the Nform installation.

; Do not delete these files.

1NL; [550]
;You must specify the IP address/ host name of the the Nform server to connect to when single sign on mechanism (SS0) is €
12'; Nformserver = 10.203.90.165

< il | »

DESCRIPTION

1 Delete the semi-colon for these lines.

6. Setthe value for the line to the IP address of the SSO server.
The following figure shows the NformViewer.ini with the correct formatting.

/| NformViewer.ini - Notepad
File Edit Format View Help
; Nformviewer.ini -

; Place this in the user subdirectory of the Nform installation.
; Do not delete these files.

[sso]
;You must specify the IP address/ host name of the the Nform server to connect to when single sign on mechanism (SSO) is k
Nformserver = 10.203.90.165

< 1 | »

7. Restart the Nform server for the changes to take effect:
e On the Nform Viewer menu bar, click Application > Nform Tools.
e Onthe Nform Tools dialog, click Application > Service.
e On Service Control, click Restart.

SSO is enabled.
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14 USING THE TOOLS MENU

The Tools menu offers options to export data to text files that may be opened with a text editor,
spreadsheet program or PDF reader. Logs that may be exported include:

e Alarm History log

e Action History log

e Data Log History

The Tools menu also permits creating reports in text or chart form that detail the status or operation of a
device, either at a particular time or during a specified period.

14.1 Export Alarm History

The Alarm History log may be exported as a text file that can be viewed or edited with a text editor or
spreadsheet program. You may specify the type of alarm, the time period and the type of text file.
1. Start the Viewer.

2. Click the Tools menu, choose Export and then choose Alarm History to open the Export Alarm
History window.

3. Specify which category of alarms to export in the Alarm Type area:
e Device alarms - export alarms for selected devices only—for example, UPS on battery

e Application alarms - export program-related alarms only—for example, Service started

e Allalarms - export both types of alarms (device and application) for all devices
4. (Only if Device alarms is selected:) Place a check mark 4 to the left of each device to include or:

e Click Select all to choose all devices.
e Click Clear all to remove all check marks.

5. The default Start Date and End Date for the exported file include all records, ranging from the
oldest alarm in the database to the latest, or most recent.

To change a date, click Start from alarm with specified date or End with specified date and
choose a date from the calendar below the button.

6. Inthe Separator box, choose the type of character to use between fields in the exported file:
comma () (the default), semicolon ¢) or tilde (~).

7. The File box displays the default location—Nform\user\export—for the exported file. The file
name includes the date and time with the extension .csv.

To change this, enter the full path in the File box or click Change to browse for the location.
8. Click OK to export the file. A message window appears after the process is complete.

The exported text file has headings in the first row, as in the following example.

AlarmRecvDttm, MgdDeviceName, MgdDeviceAddress, Alarmld, AlarmName, AlarmSev, AlarmStatus, AckDttm,
AckUsrName, ClosedDttm, ClosedUsrName, Incident

2008-07-07 08:44:14, Nform, , 12, Service started,Info,Unacknowledged,, ,, , ,

2008-07-07 08:44:36, Nform, , 13, Device monitoring started,Info,Unacknowledged,, ,, , ,

2008-07-07 08:44:40, UPS_192.168.0.11, 192.168.0.11, 15, No Alarms Present,Info,Unacknowledged,, ,, , ,
2008-07-07 08:44:53, UPS_192.168.0.125, 192.168.0.125, 16, Communications Lost,Critical,Unacknowledged,, ,, , ,
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14.2 Export Action History

The Action History log may be exported as a text file that can be viewed or edited with a text editor or
spreadsheet program. You may specify the type of alarm that triggered any action, the time period and
the type of text file.

1. Start the Viewer.

2. Click the Tools menu, choose Export and then choose Action History to open the Export Action
History window.

3. Specify which category of alarms that triggered any action to export in the Alarm Type area:
e Device alarms - export alarms for selected devices only—for example, UPS on battery

e Application alarms - export program-related alarms only—for example, Service started

e Allalarms - export both types of alarms (device and application) for all devices
4. (Only if Device alarms is selected:) Place a check mark 4 to the left of each device to include or:

e Click Select all to choose all devices.
e Click Clear all to remove all check marks.

5. The default Start Date and End Date for the exported file include all records, ranging from the
oldest action in the database to the latest, or most recent.

To change a date, click Start from action with specified date or End with specified date and
choose a date from the calendar below the button.

6. Inthe Separator box, choose the type of character to use between fields in the exported file:
comma () (the default), semicolon () or tilde (~).

7. The File box displays the default location—Nform\user\export—for the exported file. The file
name includes the date and time with the extension .csv.

To change this, enter the full path in the File box or click Change to browse for the location.
8. Click OK to export the file. A message window appears after the process is complete.

The exported text file has headings in the first row, as in the following example.

AlarmRecvDttm, MgdDeviceName, MgdDeviceAddress, Alarmld, AlarmName, AlarmSev, AlarmStatus, AckDttm,
AckUsrName, ClosedDttm, ClosedUsrName, Incident

2008-07-11 12:34:13, Nform, , 1, Service started,Info,Closed,2008-07-14 00:30:18, System,2008-07-14 00:30:18, System, ,
2008-07-11 12:43:39, Precision Cooling_192.168.203.234, 192.168.203.234, 6, Communications Restored,Info,Closed,2008-
07-14 00:37:31, System,2008-07-14 00:37:31, System, ,

2008-07-15 13:21:13, UPS_192.168.202.191, 192.168.202.191, 2024, Communications Lost,Critical,Closed,2008-07-15
15:50:38, System,2008-07-15 15:50:38, System, ,

2008-07-15 13:22:02, UPS_192.168.200.127, 192.168.200.127, 2025, upsTrapOnBattery,Warning,Closed,2008-07-15
15:51:03, System,2008-07-15 15:51:03, System, ,
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14.3 Export Data Log History

The Data Log History may be exported as a text file that can be viewed or edited with a text editor or
spreadsheet program. You may export all records (the default) or select a time period and particular
logged data points. You may also choose a comma-delimited (default) or other type of text file.

1. Start the Viewer. This feature requires logged data via Data Logging or the Read Data action
(see Data Logging on page 53 and Configure Read Data Actions on page 78). Data logging
requires a license with Advanced Communications (see Ordering Parts and Licenses From
Vertiv on page 129).

2. Click the Tools menu, choose Export and then choose Data Log History to open the Export
Data Log window.

3. Click Next.

4. Place a check mark M to the left of each device toinclude or:

e Click Select all to choose all devices.
e Click Clear all to remove all check marks.

5. The default Start Date and End Date for the exported file include all records, ranging from the
oldest to the latest.

To change a date, click Start from records with specified date or End with specified date record
and choose a date from the calendar below the button.
6. Click Next.

7. Thelist will contain data points that are currently being logged. Place a check mark M to the
left of each data point toinclude or:

e Click Select all to choose all data points.
e Click Clear all to remove all check marks.

e Place acheck mark M in Export all logged data points to include those that were
previously logged but are not currently being logged.

8. Click Next.

9. Inthe Separator box, choose the type of character to use between fields in the exported file:
comma () (the default), semicolon () or tilde ().

10. The File box displays the default location—Nform\user\export—for the exported file. The file
name includes the date and time with the extension .csv.

To change this, enter the full path in the File box or click Change to browse for the location.

11. Click Next to export the file.

12. A message in the next window reports whether the exporting was successful. Click Finish to
return to the Viewer.

The exported text file has headings in the first row, as in the following example.
RecvDttm, LoggingResult, LoggingStatus, MgdDeviceName, ModuleName, DataPointName, DataValue, DataUnits

2008-07-07 08:46:19, Success, 0, UPS_192.168.0.11, , upsSecondsOnBattery, 0, sec,
2008-07-07 08:46:19, Success, 0, UPS_192.168.0.11, , upsEstimatedMinutesRemaining, 126, min,
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14.4 Reports

Tocreate a report about a monitored device, Click the Tools menu and choose Reports.

e Inthe Reports window, Click the Add button.

e Choose the type of report. The available choices will depend on the devices being monitored.
Possible options are:

e UPS Asset
e UPS Status
e Rack PDU power usage
e Rack PDU temperatures
e Rack PDU utilization
e Click OK.
e Configure the report’s properties
e Name the report; using a logical name will assist in understanding the data

e Givethereport a description to assist in understanding the data. A report is generated
for each device.

e Choose Latest or Historical to set the report’s time frame. Choosing Historical enables the
setting the period beside Last.

e Access, set to Private in the example, determines who can view the report. Private
restricts the report to the report’s creator. Setting access to Public permits others to view
the report. Private is indicated by a latched lock, Public by an open lock.

o Display type determines how the report appears. A List is a spreadsheet; Chart shows
data points at the specified series of times graphically. Lists are more useful in showing a
device's status at a particular time. Charts are helpful in showing a device’s history.
Because of the nature of the data, charts are available only for historical data.

o Data selection permits choosing All Devices or one or more devices.

e Click the Preview button to see a dummy report with the selected properties. Nform does not
collect data for the preview, instead generating random data points to show the report’s
general appearance.
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e Click OK tofinish setting the report’s properties. This saves the report’s settings and closes the
report properties window. (T his saves only the settings that will be used to generate the
report.)

e Click View in the main Reports window to generate and see the report.

Figure 13.1 Example reports

Report Viewer Report Viewer
1) Show tite on each page ! ate rang L %) Show tte on each page

Start date: 2012032 Enddate: 20120725 Stat date: 20150226 Enddate: 20150305

et B2 5K L foft b W et 3 2 5 H 4] 1ofs b W

Rack PDU Power Usage PomeIELE
PowerUsageRept [—— =

PDU Data Point Current Units  Captured Time

RackPDU_126.4.200.110
PDU Current 03[AAC 20150324 09:02:32

[FOU Newtral Current Measurement | 0.02[AAC___|2015-03-24 090232 |
RackPDU_126.4.200.111

. Current L2 .04 [AAC_ [2015-03-24 09:02:32
e DU Current L3 AS|AAC 20150324 09:02:32
[PDU Current L1 UAS[AAC  |2015-03-24 09:02:32 - - .|
Page 10f 1 12 J S peewC=——f=——( — T o C
v —
ITEM DESCRIPTION
1 List report
2 Chart report

Reports are not automatically saved. To retain a report, export it by clicking on the Tools menu, choosing
Export and selecting the report.

Once areport is generated for one or more devices, the settings can be used later to generate a report for
the same devices, time period and type of report.

To view such a report, go to Reports page, select a report and click View. Liebert Nform will pull
information from the database as specified in the previous report and display the new data

After a report is generated, its properties can be edited to show a different time, add or remove devices.
The time period may be changed in the View window. Adding or removing a device requires returning the
Reports window and choosing Edit.

NOTE: When creating a new report shortly after a server start or after adding new devices, verify that
all devices are ready to communicate by selecting each device in the navigation view’s Parametrics tab
to ensure that data points are being read.
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15 USING THE HELP MENU

The Help menu lets you open Liebert Nform help to the Contents or Index tab, view a list of device types
supported by Liebert Nform, open Liebert Nform help to access technical support contact information,
check for updates to the Nform application or supported devices (DTD) and view details about Liebert
Nform.

15.1 Contents
Use this option to open Liebert Nform help to the Contents tab.

e On the Viewer, click the Help > Contents on the menu bar.
The NformHelp window opens with the Contents tab selected

15.2 Index
Use this option to open Liebert Nform help to the Index tab.

e On the Viewer, click the Help > Index on the menu bar.
The NformHelp window opens with the Index tab selected.

15.3 Supported Device Types
Use this option to view a list of device types supported by the Nform software.

e Onthe Viewer, click the Help > Supported Device Types on the menu bar.
The Supported Device Types window displays a list of devices along with the Category icon
and name and the Protocol, as shown below.

15.4 Technical Support
Use this option to open Liebert Nform help to display contact information for technical support.

e On the Viewer, click the Help > Technical Support on the menu bar.
The NformHelp window opens to the section with contact information for tech support.
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15.5 Check for Updates

You may check manually for updates to the Liebert Nform software and device support (DTD) files at any
time. See Server Options - Updates Tab on page 45 to have this done automatically.

To check for updates manually:
e Start the Viewer with permission to manage licenses (see Assigning Users to Groups on page
84).
e Click the Help > Check for Updates on the menu bar.
e Ifnoupdatesare available, a notification window appears.
e The Updates Available window displays all updates that may be installed. The example
below shows the three types—DTD (an updated device support file), Patch (a software
patch) and Product (a software update)—along with a description, the file name and

whether the file has been downloaded. (The Download Directory appears only if the
Viewer is running on the Nform server.)

The Updates Available button, @ ,appearsin the Viewer when updates are available. Clicking on this
button opens the Updates Available window described previously.

To download updates manually, go to the Software Assurance Web site (see Technical support contact
information on page 7).

15.6 About Liebert Nform

View details on Nform Viewer version, server, database, installed license keys, registration and how to
contact technical support.

e Onthe Viewer, click the Help > About Liebert Nform on the menu bar.
The about dialog opens.

e Click any tab—Viewer, Server, Database, License or Registration—to view the appropriate
information. All tabs display the same contact information in the Support section in the bottom
half of the window.

e Click OK toclose the window.
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16 OPERATION - USING THE VIEWER

The Viewer has three tabs that offer different views of managed devices and monitored device data,
described in the following sections:

Dashboard Tab on page 97 - quick graphical look at the current status of managed devices
Navigate Tab - Area on page 102 - hierarchical view of configured areas, with detailed data
Navigate Tab - Device on page 104 - hierarchical view of managed devices, with detailed data
Alarms Tab on page 108 - view and management of alarm data

16.1 Dashboard Tab

The Dashboard tab is active when the Viewer is launched, providing a quick summary of the status of
monitored and managed devices. For features available in the Dashboard view, refer to:

Dashboard View on page 98 - overview of the Dashboard window

Select Devices for Gadgets on page 98 - use status buttons and filters to select devices
Customize Gadgets on page 107 - limit devices shown, change graph type and colors
Add Gadgets on page 101 - create a new gadget

Global Gadget Options on page 102 - additional options to change the appearance of any pie
chart
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16.1.1 Dashboard View
The Dashboard tab is the default view, showing all of the devices in gadgets, when the Viewer is opened.

NOTE: Changing the size of the system-display text from 100% may affect the appearance and location
of the icons and menus.

Figure 15.1 Dashboard tab view

Administrator - Liebert® Nform o B X

Application  View  Configure  Tools  Help

Liebert Nform

= S
7 N
I DASHBOARD Y)NAVIGATE ) ALARMS )
< 7,
S~ -

Device Status: All

Device Description

Alarm Status: All 2 Alarm Severity: All

ITEM DESCRIPTION

1 Dashboard tab

2 Gadgets

o Click the Dashboard tab to display gadgets that show device status data in graph or list formin
the viewer's display area.

e The following default gadgets appear after installation (see Add Gadgets on page 101to add
gadgets):

e Device Status - list of managed devices by status: No communication, Normal or Alarm

e Alarm Status - 3D graph of managed devices currently in alarm
o Alarm Severity - 3D graph of managed devices by level of alarm severity

16.1.2 Select Devices for Gadgets

Status buttons and filters offer a quick way to select which devices to show in gadgets.
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Use Status Buttons to Show Device Status View

A status button may be used to toggle between a list of devices with that status and the default view:

e Click a status button—the example below shows No communication. The button has a gray

outling, the name of the selected state appears above the Viewer Display Area and gadgetsin
the display area show only devices in that state.

e Each device status view—No communication, Normal and Alarm—has a Device Status list

gadget by default. Customized gadgets may be added to any view and will be pre-filtered with
devices in the selected state. Device status views operate independently.

e When the status button has a gray outline, click again to restore the default view showing all
devices and all gadgets. Toggle between views with any of the three status buttons.

Figure 15.2 Using status buttons

Liebert’'Nform @

0 0

DASHBOARD ) NAVIGATE » ALARMS )

Device Status: All

Devic Description

ITEM DESCRIPTION

1 Status button selected, outlined in gray.
2 Name of selected status category (Maintenance in this example).
3 The device-status gadget shows only the devices in the selected status category (Maintenance).
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Apply Filters
Afilter may be applied in any gadget to show only devices that meet the specified criteria:

e Enter criteria in the Filter box at the bottom of the window—the example below shows a
different filter for each window: MPX, Nform and 714. The text must appear in the device name,

description, IP address or status.

e Pressthe Enter key. The gadget shows all devices that meet the criteria.

e Hover the mouse over a pie segment to reveal the number and percentage of devicesin the
chart.

e Toremove the filter and show all devices, simply delete the text in the Filter box and press
Enter.

Figure 15.3 Filters on gadgets

Device Status: All = [=] £2

Description Address Status
Liebert | Trust Adapt Series 1264 2 /

Liebert | Trust

Alarm Status: All = =] 2

Setup...

ITEM DESCRIPTION

1 Filter on the alarm-status gadget

2 Filter on the alarm-severity gadget
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16.1.3 Customize Gadgets

Each gadget may be customized to limit the number of devices shown, change the type of graph and
choose different colors for the graph categories. Also see Global Gadget Options on page 102 for
additional sizing and label options for pie charts.

To customize a gadget:
o Click Setup in the bottom right corner of any gadget to open an Edit window.

e At thetop of the Edit window, choose groups of devices to display in this type of graph (the
default is All devices):

e Device category—for example, UPS
e Device type—for example, Liebert GXT UPS/Web Card
e Manufacturer—for example, Liebert

e Inthe Specific Device section, choose a single device to display in the graph (the default is AlD:

e Tochoose a device by IP address, click Show addresses, then select from the drop-down
list.

e Tochoose a device by name, click Show names, then select from the list.
e Inthe Display Type list, choose the type of graph for this gadget:
e 3D Pie Chart - three-dimensional circle graph (default)

e 2D Pie Chart - two-dimensional circle graph
e List - color-coded text listing of alarms or devices in each category

e Inthe Slice Colors list, click a category—for example, Normal or Unacknowledged—then click
the color box to change the color representing that category.

e Inthe Color window, choose a color from the Basic colors list at the top (or click the Define
Custom Colors button to select a different color). The selected color is outlined. Click OK to
close the Color window.

o Click the Reset to Global button to apply global options to this gadget (see Global Gadget
Options on page 102). This button is disabled if no gadget properties have been customized.

e Click Apply at any time to view the changes without closing the Edit window.
e When finished, click OK to save changes (or Cancel to close without saving).

16.1.4 Add Gadgets

Besides the three default gadgets, additional gadgets may be created. This feature permits separate
gadgets showing the status of UPSs and cooling units, for example.

Tocreate a gadget:

e Click the Alarms or Communication button directly below the Dashboard tab to open an Add
window.
e Inthe Add window, select the options for the new gadget (see Customize Gadgets on page 101.

e When finished, click OK.
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16.1.5 Global Gadget Options
The pie chart size and labels may be customized in any gadget. To do this:
e Click Global Options in the right side of the window—with the Dashboard tab selected—to
open the Configure Global Gadget Display window.
e Click the tab for the gadget to be changed:
e Tochange the Device Status pie chart, click the Communication tab.
e Tochange the Alarm Status pie chart, click the Alarms tab, then the Alarm Status tab.
e Tochangethe Alarm Severity pie chart, click the Alarms tab, then the Alarm Severity tab.
e For each category:
e Click the Slice color box to change the color (see Customize Gadgets on page 101.

e Valid Offset values range from O to 1(default offset is 0.05 for each slice, 0.25 for pie
height).

e Place a check mark M for each additional option to be activated:
o Fit chart - cause the graph tofill the gadget regardless of window size.
e Turn labels on (checked by default) - show the Slice Name for each category on the
graph
e Show zeroslice - show a label for any slice representing a category with no devices or
alarms (if Turn labels on is also checked)
e Click Apply at any time to view the changes without closing the Edit window.
e When finished, click OK to save changes (or Cancel to close without saving).

16.2 Navigate Tab - Area

The Navigate tab displays managed devices and floor plans in a navigation tree in the left side of the
window. Tabs in the right side of the window offer options to display various types of data for a selected
area or device.

The tabs vary, depending on whether an area or a device is selected in the left side of the window. The
options for a selected area are:
e Navigate - Floor Plan View on page 103 - display of placement of devices in the selected area
e Navigate - Alarms View on page 103 - listing of alarms for the selected area
e Navigate - Info Links View on page 104 - click-able links to relevant Web pages or computer
files

The default navigation view—All Devices—shows every device that has been added to the Managed
Devices list (see Add Devices to the Configuration on page 47).

Customized views may be created for any reason and may be specified as the opening view for any user
(see Configuring Views for the Navigate Tab on page 59).

Double-clicking the arrow next to the tab name, > opens the Navigate view in a separate window, which
can be dragged anywhere on the screen or to another monitor. The Navigate tab disappears from the
viewer as long as the separate window remains open.
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Figure 15.4 View options for areas on the Navigate tab
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16.2.1 Navigate - Floor Plan View

e Click the Navigate tab, then click an area in the tree at left.

e Intheright side of the window, click the Floor Plan tab to display the area’s floor plan showing
configured placement of devices in the selected area. Icons indicate the status of any devices
that have been configured in the floor plan (see Informational Icons in the Navigation Tree on
page 1.

16.2.2 Navigate - Alarms View

The Alarms view in the Navigate tab displays alarm history data for a selected area. Authorized users may
acknowledge and close alarms and add comments and incident reports to any alarm from this window.

This window offers the same alarm features as the Alarms tab (see Alarms Tab on page 108). The Alarms
view described in this section shows alarms for all devices that are part of the selected area.

Toview this data:

e Click the Navigate tab, then click an area in the tree at left—the example below shows the All
Devices area selected.

e Intheright side of the window, click the Alarms tab to display alarm history data for the
selected area in the Viewer Display Area. The alarm list shows details about the time of
occurrence, type of alarm, source of the alarm, its severity and any comments or incidents. (If
an alarm was received during a scheduled maintenance and a Reason was specified, that text
appearsin the Incident column.)

e Click an alarmin the list, then click any of the following buttons above the alarm list for
additional options, which are available to users with permission to manage alarms (see
Assigning Users to Groups on page 84):

e Acknowledge - to acknowledge the selected alarm.
e Close - to remove the selected alarm from the display.

e Details - to view or add comments, incident reports and other alarm information in the
Alarm Details window (see Alarms Tab on page 108 for more information).
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16.2.3 Navigate - Info Links View

The Info Links tab displays information links for a selected area. These are user-defined links to Web page
or files that pertain to this area.

To view this data:

e Click the Navigate tab, then click an area in the tree at left.

¢ Intheright side of the window, click the Info Links tab to display configured links for the
selected area in the Viewer Display Area.

o User-defined info links are configured by users. For details on adding, editing or deleting these
links, refer to:

e InfoLinks on page 52 for details on adding or changing an info link
e Add or Edit an Area on page 60 to add an info link for an area
e Group Properties - Logical Groups on page 65 to add an info link for a logical group

16.3 Navigate Tab - Device

The Navigate tab displays managed devices and floor plansin a navigation tree in the left side of the
window. Tabs in the right side of the window offer options to display various types of data for a selected
area or device.

The tabs vary, depending on whether an area or a device is selected in the left side of the window. The
options for a device are:
e Navigate - Web View on page 105 - access to the device using a Web browser interface
e Navigate - Parametrics View on page 105 - tabular display of parametric data for the device
¢ Navigate - Alarms View on page 106 - listing of alarms for the selected device
e Navigate - Trends View on page 106 - graph of data points collected through data logging
e Navigate - Info Links View on page 104 - click-able links to relevant Web pages or computer
files

The default navigation view—All Devices—shows every device that has been added to the Managed
Devices list (see Add Devices to the Configuration on page 47).

Customized views may be created for any reason and may be specified as the opening view for any user
(see Configuring Views for the Navigate Tab on page 59).

Double-clicking the arrow next to the tab name, > opens the Navigate view in a separate window, which
can be dragged anywhere on the screen or to another monitor. The Navigate tab disappears from the
original window as long as the separate window remains open.
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Figure 15.5 View options for devices on the Navigate tab
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16.3.1 Navigate - Web View

e Click the Navigate tab, then click a device in the tree at left.

e Intheright side of the window, click the Web tab to display the device’'s data in a Web browser
view. A message appears if the device does not have a Web card or if communication has been
lost.

e Toviewthe same device data in the computer’s default Web browser, click View in browser.
The Web browser opens and connects to the device’s IP address.

16.3.2 Navigate - Parametrics View
The Parametrics tab displays parametric data for the selected device.
To view this data:

e Click the Navigate tab, then click a device in the tree at left.

e Intheright side of the window, click the Parametrics tab to display parametric data for the
selected device in the Viewer Display Area.

e Twotypes of parametric data are available. Click one of these options to display device data or
statistics for the device.

e Data - the default, shown above left
e Statistics - options depend on the device selected—SNMP in the example above right
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e Tosort thelist, click a column heading—for example, Name.
e Click these tabs above the list for additional options:

e Details - open a window that displays a definition of the selected item. Click Close to
return to the Parametrics view.

o Refresh - update the display with the most current device information.

e Edit - make changes to the device itself—available only to users with permission to set
device data (see Assigning Users to Groups on page 84).

When Edit mode is active, this tab toggles to Read only - leave Edit mode and return to
display-only mode (see Device-properties Alarms tab on page 53 for more information).

16.3.3 Navigate - Alarms View

The Alarms view in the Navigate tab displays alarm history data for a selected device. Authorized users
may acknowledge and close alarms and add comments and incident reports to any alarm from this
window.

This window offers the same alarm features as the Alarms tab (see Alarms Tab on page 108). The Alarms
view described in this section shows alarms for a single device, rather than for all devices.

Toview this data:

e Click the Navigate tab, then click a device in the tree at left.

e Intheright side of the window, click the Alarms tab to display alarm history data for the
selected device in the Viewer Display Area. The alarm list shows details about the time of
occurrence, type of alarm, source of the alarm, its severity and any comments or incidents. (If
an alarm was received during a scheduled maintenance and a Reason was specified, that text
appearsin the Incident column.)

e Clickanalarmin the list, then click these tabs above the list for additional options, which are
available to users with permission to manage alarms (see Assigning Users to Groups on page
84):

e Acknowledge - to acknowledge the selected alarm.
e Close - toremove the selected alarm from the display.

e Details - to view or add comments, incident reports and other alarm information in the
Alarm Details window (see Alarms Tab on page 108 for more information).

16.3.4 Navigate - Trends View

NOTE: Data logging requires a license with Advanced Communications (see Ordering Parts and
Licenses From Vertiv on page 129). This feature requires logged data via Data Logging or the Read
Data action (see Data Logging on page 53 and Configure Read Data Actions on page 78).

The Trends function in the Navigate tab displays a graph of data points for a selected device. The data
points must be selected for logging and graphing before the graph may be viewed.
To select and view this data:

e Click the Navigate tab (below left), then click a device in the tree (left side of the window).

e Intheright side of the window, click the Trends tab.

e Click the Refresh button—above the graph to the left—to update the graph. The graph is not
updated with new data until the Refresh button is clicked.
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e Click the Setup button above the graph to open the Trend Data Selection window, shown
above right. See Data Logging on page 53 for details on the Device Data Logging window, a
similar window—minus the Graph column—where points may be selected for logging.

e Place acheck mark M in the Graph column to select a data point (up to eight) to be
graphed. This also places a check mark in the Log column, indicating the parameter will
be logged.

e Inthe Sampling Interval (minutes) box, choose the time interval for sampling all selected
data points. The default is 30 minutes; valid entries are from 1to 10080 minutes (7 days).

e Click OK when finished. Click Refresh to update the graph in the Navigate window.

e Click the Copy data button above the graph to create a comma-delimited copy of the data
labels and values on the clipboard, which can be pasted into a text or spreadsheet file.

16.3.5 Navigate Trends - Change the Range
e Tochange the time axis, click the Range button above the graph. Specify the Duration using
either of these options, then click Refresh:
e Previous: Choose the amount of data history to display—e.g, the past 2 hours or 30 days.
e Period: Specify a range of start and end times in the From and To boxes.
e Click-and-drag to draw a rectangular area to zoom in on any portion of the graph.

e Scroll bars will appear along the axes of the graph. Those scroll bars can be used to pan. The
scroll bars will disappear when “Undo all zoom” is selected from the context menu.

e Right-click anywhere on the graph area for a pop-up menu with these additional options:

MENU OPTION DESCRIPTION

Print setup... Change settings for printing the graph

Print the graph image
Print... Send the graph to a printer

Restore original view | Undoallzoom | Restore original view after zooming or panning

Save graph image Save image as... | Save the graph as a graphic file

Copy values Copy data Copy datalabels and values to the clipboard

16.3.6 Navigate - Info Links View

The Info Links tab displays information links for a selected device. These include both click-able links to
Web pages gathered during Auto Discovery of devices and user-defined links to Web page or files that
pertain to this device.

Toview this data:

e Click the Navigate tab, then click a device in the tree at left.

e Intheright side of the window, click the Info Links tab to display configured links for the
selected device in the Viewer Display Area.
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e Permanent info links are gathered automatically during device configuration; they may not be
edited or deleted.

e User-defined info links are configured by users. For details on adding, editing or deleting these
links, refer to:

e InfoLinks on page 52 for details on adding or changing an info link
e Add or Edit an Area on page 60 to add an info link for an area
e Group Properties - Logical Groups on page 65 to add an info link for a logical group

16.4 Alarms Tab

The Alarms tab displays alarm history data for all managed devices in the current view. Authorized users
may acknowledge and close alarms and add comments and incident reports to any alarm.

This window offers the same alarm features as the Alarms view in the Navigate tab (see Navigate - Alarms
View on page 106). The Alarms tab described in this section shows alarms for all devices, rather than for a
single device.

Double-clicking the arrow next to the tab name, > opens the Alarms view in a separate window, which
can be dragged anywhere on the screen or to another monitor. The Alarms tab disappears from the
original window as long as the separate window remains open.

16.4.1 Viewing Alarms
To view this data:

e Click the Alarms tab to display alarm history data for all devices in the Viewer Display Area.
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Figure 15.6 Alarms tab and alarm-management options
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e The Viewer Display Area displays history data for each alarm (see Managing Alarms on page
10):

e Received:the time the alarm was detected by the Nform server
e Alarm:the type of alarm—e.g, Utility failure - Cleared

e Source: the source of the alarm—e.g, the Nform application (Nform) or a device
(Devicel2)

e Severity:the alarm’s level of severity (see Informational Icons in the Navigation Tree on
page 111

e Comment: an icon indicating comments added in the Alarm Details window

e Incident:a name indicating a related incident added in the Alarm Details window:

RECEIVED ALARM SOURCE SEVERITY COMMENT INCIDENT
2016-12-16 09:53:24 Utility failure - Cleared Devicel12 o Critical
2008-12-16 09:58:55 Service started Nform Informational IncidentA

e Double-clicking on a device name—e.g, Devicel2—opens the Navigate tab view of that device.
Double-clicking on any other part of an alarm listing opens the Alarm Details window (see
Managing Alarms on page 110).

e Tosort thelist, click any heading—for example, Alarm or Source.

e Color-coded numbers of acknowledged and unacknowledged alarms appear above the Detail
area.

e Foradevice in Maintenance mode (see Maintenance Mode on page 54): Any alarm received
while a device is in Maintenance mode has a Maintenance icon in the Severity column. If a
Reason was entered for a scheduled maintenance, the reason appears in the Incident column.
Informational alarms indicate when the device enters and returns from Maintenance mode.
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16.4.2 Managing Alarms

To manage alarms:

Start the Viewer with permission to manage alarms (see Assigning Users to Groups on page
84)

Click the Alarms tab to display alarm history data for all devices in the Viewer Display Area.

Use standard shift-click and control-click methods to select multiple alarms.

Select one or more alarms in the list, then click these buttons to manage alarms:

Acknowledge - to acknowledge the selected alarm
Close - to remove the selected alarm from the display

Figure 15.7 Alarm management options
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To view or add details for alarms, select one or more alarms in the list, then click the Details
button to open the Alarm Details window.

The Alarm Information at the top is for display only: the alarm name, description and other
details such as severity level and time received.

The Alarm Action Details shows a list of actions executed as a result of this alarm.

The Display Graph button is enabled only if a Read Data action—mapped to this alarm for
this device—is selected in the Alarm Action Details list. When enabled, this button
displays a trend graph (see Navigate - Trends View on page 106).

In the Alarm Status area, place a check mark M in the Acknowledge or Close box as
needed.

In the Incident box, enter a description (up to 20 characters)—for example, an event that
may have caused the alarm. This description is displayed in the Alarms view.

Enter any additional notes in the Comments box. An icon appears in the Alarms view after
a comment is added to an alarm.

When finished, click OK to save changes (or Cancel to close the dialog without saving).
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16.4.3 Informational Icons in the Navigation Tree

The Navigation tree displays icons to indicate normal operation, active alarms, communication loss and
other conditions of managed devices and floor plans.

Figure 15.8 Icons in the Navigation tree
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The following table summarizes the meaning of icons that indicate the status of monitored and managed
devices.

Table 15.1 Informational icons summary

ICON DESCRIPTION

Device Icons

Battery monitoring device

I/O device

Precision cooling device

Rack PDU device

UPS device

Other device

[

é Power device
*

:

i

Status Icons (next to device)

] o
=) Device in normal status

] ) ) ) )
. Active alarm received from this device

Device in maintenance mode
r i Appears for adevice in maintenance mode
above any status icon—e.g., Active alarm or No communication.

No communication with this device
When this “no communication” symbol appears,
verify that your network cables are connected.

o
1=

Iffurther action is required, consult your SNMP card user manual.

Alarm Icons
o Critical alarm

Warning alarm

Informational alarm

Maintenance mode
See Maintenance Mode on page 54.

4
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17 RUNNING LIEBERT NFORM

After installation, the Liebert Nform service begins running in the background, monitoring and managing
all configured devices.

The Liebert Nform service continues running constantly, but it may be stopped and restarted through
the following methods:

METHOD FOR DETAILS, SEE:

e The Windows Services application allows you to stop the Liebert Nform Stop the Liebert Nform Service on
service manually. page 113

e The same Services application allows you to resume the Liebert Nform service | Restart the Liebert Nform Service on
without having to restart the computer. page 114

e Theservice is stopped automatically during operations performed in the Tools Using s Tosls 67 Ege 115

application.
o After being stopped automatically, the service restarts automatically when Application Menu - Close Nform Tools
exiting the Tools application. on page 117

NOTE: Stopping the service prevents Liebert Nform from monitoring and managing your devices.

17.1 Starting or Stopping the Liebert Nform Service

Under normal circumstances, you will not need to start or stop the Liebert Nform service manually. This
may be done in the Nform Tools application (see Application Menu - Service on page 117) or from the
Windows Services application, as described below.

17.1.1 Open the Services Application

1. Click the Start button, then Control Panel.
2. Inthe Control Panel window:
e (Windows 7 and Server 2008 R2) Click System and Security.

e (Windows Vista and Server 2008) Click System and Maintenance.
e (Windows Server 2003) Click Performance and Maintenance.

Click Administrative Tools.
Double-Click Services.
e (Windows Vista & Server 2008) Click Continue in the User Account Control window.

5. Perform the following functions as needed.

~w

17.1.2 Verify Whether the Liebert Nform Service is Running (Status column)
e Checkthe Status column in the Services window to see whether the Liebert Nform service is
running (Started) or not running (blank).
17.1.3 Stop the Liebert Nform Service
This action prevents Liebert Nform from monitoring and managing your devices. To stop the service:

e Right-Click Liebert Nform, then Click Stop in the pop-up menu.
(Or Click Liebert Nform, then on the Action menu at the top of the window, then Stop.)
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17.1.4 Restart the Liebert Nform Service

The service starts automatically when the monitoring workstation is restarted. To start it manually:
e On the desktop, click Start > Control Panel, then select System and Security > Administrative
Tools > Services.
e Inthe Services dialog, right-click Liebert Nform, then click Restart in the pop-up menu.
(Or click Liebert Nform, then on the Action menu at the top of the window, then Restart.)
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18 USING NFORM TOOLS

This section describes the following options available in the Nform Tools application:

Stop, start or restart the Nform service
Change database connection options for an SQL Server database
Switch from one type of database—bundled or SQL Server—to another

Perform database maintenance operations on a bundled database: verify and repair, shrink
and compact, upgrade from an older version (rarely needed)

Install device definitions (DTDs) to expand Nform support for additional devices
Import Liebert Nform version 2.X data from one server into version 4.X on a different server

18.1 Open the Nform Tools Application From the Start Button

Nform Tools may be opened from the Start button as described in this section or from the Nform Viewer
(see Nform Tools on page 3D.

To open the application from the Start button:

18 Using Nform Tools

Click the Start button, then on Programs, Liebert Nform and finally Nform Tools.
(Windows Vista, Server 2008 and later) A User Account Control (UAC) message appears,
requesting your permission to start the application. Click Allow to continue.

The Liebert Nform Tools window opens.

Menus at the top of the window—Application, Database and Tools—are described in the
following sections:

e Menusin Nform Tools on page 116
e Application Menu on page 116
e Database Menu on page 117
e Tools Menu on page 120
The status of the Nform service appears at bottom left: Running or Stopped.
Some operations in the Nform Tools application require stopping the Liebert Nform service, so

it is stopped automatically when needed. If the service is stopped for this or any reason, it
restarts automatically when the Nform Tools application is closed.
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18.2 Menus in Nform Tools

Menus at the top of the Liebert Nform Tools window include: Application, Database and Tools. Each menu
has a drop-down list of options, as shown the following table.

Table17.1 Nform Tools menu options - summary

FOR MORE DETAILS,

OPTION FUNCTION SEE:
Service Start, stop or restart the Liebert Nform service. Appl!oatlon Menu -
Service on page 117
Aoplication Close the Tools application. Application Menu -
PP Exit (Ifthe Liebert Nform service is stopped, it restarts automatically when Close Nform Tools
the application is closed.) on page 117
: : : : Database -
) Make changes to database connection options or specify a different type )
Connection ) ) . Connection on page
of database after installation (see step 5 of Installation on page 9). 7
Verify* Check the integrity of an Nform database. If a database fails the test, use Database - Verify on
Y the Repair option to try to fixit. page 118
Repair* Attempt to fix a corrupted Nform database—for example, if a database Database - Repair on
P fails the Verify test. page 118
Shrink* Reduce database size by moving free space, then truncating the file (less Database - Shrink on
thorough but quicker than the Compact option). page 119
Database
Compact* Reduce database size by creating a new file from the existing database file Database - Compact
P (more thorough but takes longer than the Shrink option). on page 119
(Not needed in most cases)
Use this option for manually upgrading Nform 4.0
embedded databases (SQL CE™ 3.1 to the
Upgrade? current Nform 4.1(SQL CE 3.5) format. Er?taabaesjz-oUpgrade
The SQL CE database is adequate for monitoring fewer than 50 devices. Pag
For 50 or more devices, We recommend installing the SQL Server
database.
Instal DTD Install Device Type Definitions for new equipment Tools Menu - Install
Tools from a package file available from Vertiv™. DTD on page 120
Import Liebert Nform version 2.X data from one server into version 4.1on Tools Menu - Import
Tools .
adifferent server. 2.5 Dataon page 121
* These Database menu options apply only to bundled databases (see step 5 of Installation on page 9), not SQL Server databases.
**SQL CE = Microsoft SQL Server Compact Edition

18.3 Application Menu
This menu has options for:

e Start, stop or restart the Liebert Nform service (Application Menu - Service on page 117)
e Exiting the Tools application (Application Menu - Close Nform Tools on page 117)
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18.3.1 Application Menu - Service
This menu item allows you to stop, start or restart the Liebert Nform service. To do this:

e LogintoWindows on the Nform server as a user with administrator privileges on that machine.

e Click the Application menu in the Liebert Nform Tools window, then on Service.

e The Service Control window displays the status of the Nform service—Running or Stopped—
and has buttons to Stop, Start or Restart the Nform service.

e Aprogress bar appears after you click a button to stop, start or restart the Nform service.
When the process is complete, the new status appears in the Nform Service Status box.

o [fthe Nform Viewer is open when the service is stopped, a message alert indicates the loss of
communication, along with a reminder to restart the service and log in again.

18.3.2 Application Menu - Close Nform Tools

Some Nform Tools operations cannot be performed with the Liebert Nform service running, so the service
is stopped automatically. If the service is stopped, it restarts automatically when the Tools application is
closed as described in this section.

For more details on the Liebert Nform service and other ways to start or stop the service, see Running
Liebert Nform on page 113 and Application Menu - Service on page 117.

To close the Nform Tools application:

e Click the Application menu in the Liebert Nform Tools window, then on Exit.

e [fthe Liebert Nform service is stopped, a Service Control window displays a message that the
service is restarting. If this message appears, click OK to close the window.

18.4 Database Menu

This menu has options for:

e Making changes to database connection options (Database - Connection on page 117)

e Database maintenance tasks for a bundled database (Describe in the sections Database -
Verify on page 118 through Database - Upgrade on page 120)

18.4.1 Database - Connection
The Connection option is designed to allow changes to database connection options after installation.
To make changes to database connection options:

e Click the Database menu in the Liebert Nform Tools window, then on Connection.

e Toswitch to a different type of database, Click the type of database at the top of the window,
then click OK.
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e Tomake changestoconnection options, Click the type of database at the top of the window,
make the following changes as needed, then click OK when finished.

e The Data Source box displays the connection source using the format Server\Instance:

The host name or IP address of the connection server. To specify the same computer as the database server, enter

SEREr (loca)—for example:

ServerO1 OR 192.168.1.32 OR (local)

Anamed instance of the SQL Server database engine if multiple instances are running concurrently on the same

Instance | computer—for example:
(Optional)

ServerOT\Instance05 | OR 192.168.1.32\Instance05 | OR (locab\Instance05

e The Primary Database Name box displays the name of the database—for example, Nform.
This name is used for the database, alarm file (Nform.alm) and data log file (Nform.logD.
e Ifneeded, enter a log-in user name in the User Name box.

e Ifneeded, enter a log-in password in the Password box, then enter the same password in
the Confirm Password box.

18.4.2 Database - Verify

Use this option to check the integrity of an Nform database. If a database fails the test, use the Repair
option to try to fix it (see Database - Repair on page 118). This applies to bundled databases only
(Installation on page 9). The option is disabled if there is no connection to the Nform database.

Initiating this process automatically stops the Liebert Nform service if it is running.
To verify databases:

e Click the Database menu in the Liebert Nform Tools window, then on Verify.

e Inthe Embedded Database Operation window, click to place a mark M to the left of each type
of database to verify: Primary database, Alarms database, Data log database.

e When ready to proceed, click the Verify button. The Nform service will be stopped, indicated by
the status in the bottom left corner of the Tools window.

e When the operation is complete, the result—Success or Fail—appears to the right of each
selected database. If a Fail message appears, proceed to Database - Repair on page 118. If the
condition cannot be corrected with a repair operation, contact Vertiv™™ Technical Support.

e Click Close toreturn to the Liebert Nform Tools window.

18.4.3 Database - Repair

Use this option to attempt to fix a corrupted Nform database—for example, if a database fails the Verify
test (see Database - Verify on page 118). This applies to bundled databases only (Installation on page 9).
The option is disabled if there is no connection to the Nform database.

Initiating this process automatically stops the Liebert Nform service if it is running.
Torepair databases:

o Click the Database menu in the Liebert Nform Tools window, then on Repair.

e Inthe Embedded Database Operation window, click to place a mark M to the left of each type
of database to repair: Primary database, Alarms database, Data log database.
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e When ready to proceed, click the Repair button. The Nform service will be stopped, indicated
by the status in the bottom left corner of the Tools window.

e When the operation is complete, the result—Complete or Fail—appears to the right of each
selected database. If a Fail message appears, contact Vertiv™ Technical Support.

e Click Close toreturn tothe Liebert Nform Tools window.

18.4.4 Database - Shrink

Use this option to reduce database size by moving free space, then truncating the file. This is less
thorough but quicker than the Compact option (Database - Compact on page 119). This applies to
bundled databases only (Installation on page 9). The option is disabled if there is no connection to the
Nform database.

Initiating this process automatically stops the Liebert Nform service if it is running.

To shrink databases:

e Click the Database menu in the Liebert Nform Tools window, then on Shrink.

e Inthe Embedded Database Operation window, click to place a mark M to the left of each type
of database to shrink: Primary database, Alarms database, Data log database.

e When ready to proceed, click the Shrink button. The Nform service will be stopped, indicated
by the status in the bottom left corner of the Tools window.

e When the operation is complete, the result—Complete or Fail—appears to the right of each
selected database. If a Fail message appears, contact Vertiv™ Technical Support.

e Click Close toreturn tothe Liebert Nform Tools window.

18.4.5 Database - Compact

Use this option to reduce database size by creating a new file from the existing database file. This is more
thorough but takes longer than the Shrink option (Database - Shrink on page 119). This applies to

bundled databases only (Installation on page 9). The option is disabled if there is no connection to the
Nform database.

Initiating this process automatically stops the Liebert Nform service if it is running.
To compact databases:

e Click the Database menu in the Liebert Nform Tools window, then on Compact.

e Inthe Embedded Database Operation window, click to place a mark M to the left of each type
of database to compact: Primary database, Alarms database, Data log database.

e When ready to proceed, click the Compact button. The Nform service will be stopped,
indicated by the status in the bottom left corner of the Tools window.

e When the operation is complete, the result—Complete or Fail—appears to the right of each
selected database. If a Fail message appears, the original database will have been renamed as
*bak (e.g, NformLog.sdf.bak) and will be unchanged. Rename the database with its original
name (e.g, NformLog.sdf), then restart the service to resume operation as before.

e Click Close toreturn tothe Liebert Nform Tools window.
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18.4.6 Database - Upgrade

This option is not needed in most cases. Use this option for manually upgrading Nform 4.0 embedded
databases (SQL CE 3.1 to the current Nform 4.1(SQL CE 35) format (SQL CE = Microsoft SQL Server
Compact Edition). This applies to bundled databases only (Installation on page 9). The option is disabled
if there is no connection to the Nform database.

Initiating this process automatically stops the Liebert Nform service if it is running.
Toupgrade databases:

e Click the Database menu in the Liebert Nform Tools window, then on Upgrade.

e Inthe Embedded Database Operation window, click to place a mark M to the left of each type
of database to upgrade: Primary database, Alarms database, Data log database.

e When ready to proceed, click the Upgrade button. The Nform service will be stopped, indicated
by the status in the bottom left corner of the Tools window.

e When the operation is complete, the result—Success or Fail—appears to the right of each
selected database. If a Fail message appears, contact Vertiv™ Technical Support.

e Click Close toreturn tothe Liebert Nform Tools window.

18.5 Tools Menu

This menu has options for:

e Downloading and installing Device Type Definition (DTD) files to expand Liebert Nform
support for additional devices (Tools Menu - Install DTD on page 120)

e Importing Liebert Nform version 2.X data from one server into version 4.X on a different server
(Tools Menu - Import 25 Data on page 121

18.5.1 Tools Menu - Install DTD
A Device Type Definition (DTD) package is a set of files that identify additional devices for Liebert Nform
to monitor and manage, besides the many device definitions installed with Liebert Nform.

DTD packages for new equipment may be obtained from Vertiv™ and may include devices made by
Vertiv™ as well as other manufacturers.

A DTD package is provided as a set of files that must be installed on the Liebert Nform server before this
type of device may be added to the managed device list.

To download and installa DTD on the Liebert Nform server:

e Onthe Nform server, Click the Tools menu in the Liebert Nform Tools window, then on Install
DTD. This opens the Install Device Type Definitions (DTD) window.

e Thelnstall Device Type Definitions (DTD) window has two sections, one for downloading a DTD
package and the other for installing the package on the Nform server:
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To Download a Package

e Todownload the file from the Liebert Web site, enter the URL in the Download Package
box, then click the Download button. After downloading, continue to the next step to
install.

To Install a Package

e After obtaining a DTD package file, enter the full path to that file in the Install Package
text box or Click the Browse button to locate the file.

e Clickthe OK button toinstall the DTD.

When finished, you may add any new device types to the configuration in the Nform Viewer (see Add
Devices to the Configuration on page 47).

18.5.2 Tools Menu - Import 2.5 Data

This feature may be used to import Liebert Nform version 2.X data from one server into version 4.X on a
different server.

To prepare for the import, see Import Exported Data from a Different Server on page 16 for details on
these steps:
e Install Liebert Nform 4.X.
e Create a temporary folder on the 4.X server, then copy the exported files from the 2.X server.
e Open Nform Tools on the 4 X server (see Open the Nform Tools Application From the Start
Button on page 115).
Toimport the data:

e Click the Tools menu in the Liebert Nform Tools window, then on Import 2.5 Data.

e Inthe Directory box, enter the full path or click the Browse button to locate the folder
containing the exported files, then click Open.

e Click Import. The import utility will stop the Nform service, import the appropriate files and
restart the service. A message confirms the process is complete.

e When finished, close the Nform Tools application by clicking on the Application menu, then on
Exit (see Application Menu - Close Nform Tools on page 117).
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19 UNINSTALLING LIEBERT NFORM / REMOVING LICENSE
KEYS

This section describes how to remove the Liebert Nform application and how to delete a license key.

19.1 Uninstalling Liebert Nform

Toremove Liebert Nform from your computer, run the Windows Add/Remove Programs, which is found in
the control panel.
1. Open the Control Panel: Click the Start button, then Settings, and finally Control Panel.

2. Inthe Control Panel window, double-click Add or Remove Programs
(in Windows Vista, double-click Programs and Features).

3. Inthelist of installed programs, above right, double-click Liebert Nform.
4. In the Application Maintenance window, click Remove to uninstall the software.
5. Inthe Liebert Nform Uninstall window, choose one of these options:

e Remove complete application to remove the Liebert Nform software, as well as device and
alarm data and all related files.

e Remove application programs only to remove the software only, keeping device and alarm
data and related files.

6. Click Remove.

7. When the process is complete, a window appears, as shown above. Click Finish to exit.

19.2 Deleting a License Key

If more than one license key is installed, there may be a need to remove a secondary license key—for
example, to move it to another computer to monitor a different group of devices.

Liebert Nform does NOT prevent users from deleting the base license, even if doing so would reduce the

authorized number of devices below the number of configured devices.

WARNING! Deleting the base license would prevent remote user login, data trending and trap
forwarding to a remote management center.

19 Uninstalling Liebert Nform / Removing License Keys
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NOTE: The initial license key permits a certain number of devices and unlimited remote users.
Supplemental license keys allow for 30, 100 or 500 additional devices. Contact your local Vertiv™
representative or see Ordering Parts and Licenses From Vertiv on page 129 for details.

At least one license key containing a device license must be installed to manage the network.

Any number of users can log into the local host.

You will not be able to log in remotely if the base license is removed.

Liebert Nform prevents users from deleting a license if:

- the deletion would reduce the number of allowed remote users to fewer than the number of logged-in
remote users.

- the deletion would reduce the number of allowed devices to fewer than the number of configured
devices.

If a license is inadvertently deleted, Liebert Nform allows the user to reinstall it (see Enter the License
Key on page 28).

Toremove a license key:
1. Start the Viewer with permission to manage licenses (see Assigning Users to Groups on page
84).

2. Click the Configure Licenses icon at the bottom of the window (or Click the Configure menu,
then choose Licenses).

3. Inthe Licenses window, Click the license key to be removed, then click the Delete button.
4. A confirmation window asks whether to continue with the deletion. Click Yes to delete the
license key (or No to cancel without deleting it).

If the license to be deleted is the only license, an alert window displays a message that the last
managed device license cannot be deleted.
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APPENDICES

Appendix A: Technical Information & Frequently Asked Questions

1.

What is a DHCP server?

DHCP is the acronym for Dynamic Host Configuration Protocol. This protocol allows host names
to be allocated dynamically when computers are connected to a network. This protocol is often
used to remotely grant a host name to a computer for a limited time, as when a student uses a
computer for a quarter or longer. See RFC-1541 for more detailed information. (RFCs are
Request For Comment documents that set forth regulations on how communication occurs on
the Internet. These documents are controlled by the Internet Engineering Task Force (IETF)
and are available for viewing at the IETF Web site.)

How do | identify possible TCP/IP port conflicts when using a UPS equipped with an SNMP
card? How do | resolve the conflict?

TCP/IP port conflicts with port 162 can be resolved by stopping the SNMP trap service from
running. This product does not support running on the same machine as a Network
Management System (NMS).

For the proper procedure to stop the SNMP services, see Running Liebert Nform on page 113.
What is a service?

Aservice is a process initiated at boot time that requires no user intervention to start and run.
A service continues to run after the user logs off the computer.
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Appendix B: Data Monitored by Liebert Nform

Liebert supplies a template for each SNMP device, containing data points and alarms applicable to that
device. The names of data points and alarms can be changed (see Configuring Views for the Navigate
Tab on page 59).

e Data points are the information Liebert Nform compiles from polling a managed SNMP device.
e Alarms are out-of-tolerance conditions that Liebert Nform reports to users.

Sample Data Points and Alarms on page 127 below show sample data points and alarms for environmental
and UPS units with SNMP cards.

B.1 Sample Data Points and Alarms

The following table shows examples of data points and alarms for a precision cooling unit.
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Table B.1 Sample data points and alarms - Precision cooling unit

DATA POINTS ALARMS

Agent lost device
communication

High temperature

Low temperature

High humidity

Low humidity

Change filter

High head pressure 1

High head pressure 2
Water under floor

Low water in humidifier
Lost power

Localalarm 1

Localalarm 2
Compressor Tlow pressure
Compressor 2 low pressure
Faulty sensor detected
Service cooling

Service humidifier

System control battery low

Agent firmware corrupt

Conditions present

Statistics run hours

Agent manufacturer

Agent model

Agent firmware version

Agent serial number

Agent reboot

Temperature setting
Temperature setting

Humidity setting

System state

Humidifying state
Dehumidifying state

Fanstate

General alarm output state
Cooling capacity state

Heating capacity state

Audible alarm state

Cooling unit 1's state

Cooling unit 2's state

Heating unit 1's state

Heating unit 2's state

Configure restart delay
Configure remote shutdown
Configure cooling service interval
Configure humidifier service interval
Configure filter service interval
Control shutdown after delay
Control start up after delay
Statistics compressor 1run hour
Statistics compressor 2 run hour

Statistics main fan run hour

Statistics humidifier run hour

Statistics reheat element 1run hour
Statistics reheat element 2 run hour
Statistics cooling mode hours

Statistics heating mode hours

Statistics humidify mode hours

Statistics dehumidify mode hours

Board battery voltage

Device manufacturer

Device model

Device firmware version

Device unit number

Device serial number

Device manufacture date
Controltemperature

Return air temperature

Supply air temperature

Control high temperature alarm setpoint
Return air high temperature alarm setpoint
Controllow temperature alarm setpoint
Return air low temperature alarm setpoint
Controltemperature

Return air temperature

Supply air temperature

Control high temperature alarm setpoint
Return air high temperature alarm setpoint
Control low temperature alarm setpoint
Return air low temperature alarm setpoint
Control humidity

Return air humidity

Supply air humidity

Humidity high alarm setpoint
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Appendix C: Ordering Parts and Licenses From Vertiv

The table below lists part numbers for items available from Vertiv™. To obtain any item, visit the Liebert
Web site at http://nformliebert.com or contact your local Vertiv™ representative, value-added reseller or

distributor.

Table C.1 Liebert Nform part and license numbers

ITEM

Liebert Nform Software on CD-
ROM

PART/ LICENSE NUMBER

NFORM-EXP

DESCRIPTION

Liebert Nform with license key! for:

e 30 devices, not expandable
e Unlimited users
e Advanced Communications—enables:

o Datalogging function (see Data Logging
on page 53)

» Read Dataaction (see SectionConfigure
Read Data Actions on page 78)

Liebert Nform Software on CD-
ROM

Liebert Nform Software on CD-
ROM

NFORM-STD

NFORM-ENT

Liebert Nform with license key!for:
e 30 devices, expandable to 4,800 with additional
license keys
e Unlimited users
e Advanced Communications—enables:

o Datalogging function (see SectionData
Logging on page 53)

» Read Dataaction (see SectionConfigure
Read Data Actions on page 78)
Liebert Nform with license key'for:
e 100 devices, expandable to 10,000 with additional
license keys
e Unlimited users
e Advanced Communications—enables:
o Datalogging function (see SectionData
Logging on page 53)
o Read Dataaction (see SectionConfigure
Read Data Actions on page 78)

e Advanced Notifications—enables:

e TrapForwarding (see SectionServer
Options - Trap Forwarding Tab on page 44)

e Forward Trap (see SectionConfigure
Forward Trap Actions on page 77)

30 Device License

100 Device License

NFORM-30D

NFORM-100D

License key? for 30 additional devices

License key? for 100 additional devices

500 Device License

Liebert Nform Upgrade to
Standard Edition

NFORM-500D

NFORM-STD-UP

License key? for 500 additional devices

License key for upgrading Liebert Nform to the Standard
Edition

1.See Add a Liebert Nform License Key on page 28 for step-by-step instructions.

3. Each additional license key must be installed separately, as described in Add a Liebert Nform License Key on page 28.
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